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Preface
Rational Suite delivers a comprehensive set of integrated tools that embody software
engineering best practices and span the entire software development lifecycle. The
Rational Suite's unparalleled level of integration improves communication both
within teams and across team boundaries, reducing development time, and
improving software quality.

This installation guide provides procedures to install Rational Suite, including an
overview of how to configure the point products within Rational Suite. Detailed
procedures about point-product configurations, as well as standalone installations,
are available in the individual point-product documentation.

Audience

This guide is intended for system administrators, project managers, and all members
of the software development team, including requirements developers, software
architects and developers, and quality engineers. It assumes a knowledge of Microsoft
Windows and its conventions.

Other Resources

� All manuals are available online, either in HTML or PDF format. The online
manuals are on the Rational Solutions for Windows Online Documentation CD.

� To send feedback about documentation for Rational products, please send e-mail
to techpubs@rational.com.

� For more information about Rational Software technical publications, see:
http://www.rational.com/documentation.

� For more information on training opportunities, see the Rational University Web
site: http://www.rational.com/university.

� For articles, discussion forums, and Web-based training courses on developing
software with Rational Suite products, join the Rational Developer Network by
selecting Start > Programs > Rational Suite > Logon to the Rational Developer Network.
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Rational Suite: Summary

This table shows which tools are included with each edition of Rational Suite.
Project

Leaders/
Managers

Analysts Developers Testers All Roles Web
Teams

Team
Unifying
Platform

Analyst
Studio

DevelopmentStudio DevelopmentStudio
RealTime Edition

TestStudio Enterprise Content
Studio

Windows Windows Windows UNIX Windows UNIX Windows Windows Windows

Tool

Te
am

U
n

if
yi

ng
P

la
tf

or
m

Rational
Unified Process

• • • • • • • • •

Rational
RequisitePro

• • • •WEB • •WEB • • •

Rational
ClearQuest

• • • •WEB • •WEB • • •

Rational SoDA • SW • SW • SW • SF • SW • SF • SW • SW • SW

Rational
ClearCase LT

• • • • • • • • •

Rational
TestManager

• • • • • • • • •

Rational
ProjectConsole

• • • • • • •

Rational Rose • M • E • U • RT •RT/U • E

Rational
PureCoverage

• • • • • •

Rational Purify • • • • • •
Rational
Quantify

• • • • • •

Rational Robot • • 
Rational
TestFactory

• •

Rational
Process
Workbench

•

Rational
NetDeploy

•

Rational
SiteLoad

•

M = Professional Data Modeler Edition
E = Enterprise Edition
U= UNIX Edition
RT = RealTime Edition
SW = Rational SoDA for Word
SF= Rational SoDA for FrameMaker
WEB = Can also be accessed through the tool’s Web interface
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Contacting Rational Technical Support

If you have questions about installing, using, or maintaining this product, contact
Rational Technical Support as follows:

Note: When you contact Rational Technical Support, please be prepared to supply the
following information:

� Your name, company name, telephone number, and e-mail address

� Your operating system, version number, and any service packs or patches you
have applied

� Product name and release number

� Your case ID number (if you are following up on a previously reported problem)

Contacting Rational Licensing Technical Support

If you have questions about acquiring license keys for your Rational Software
products, contact Rational Licensing Support as follows:

Your Location Telephone Facsimile E-mail

North America (800) 433-5444
(toll free)

(408) 863-4000
Cupertino, CA

(781) 676-2460
Lexington, MA

support@rational.com

Europe, Middle
East, Africa

+31 (0) 20-4546-200
Netherlands

+31 (0) 20-4546-201
Netherlands

support@europe.rational.com

Asia Pacific +61-2-9419-0111
Australia

+61-2-9419-0123
Australia

support@apac.rational.com

Your Location Telephone Facsimile E-mail

Asia Pacific +61-2-9419-0111 +61-2-9419-0123 license@apac.rational.com

Asia Pacific
(Japan)

+61-2-9419-0111 +61-2-9419-0123 license@japan.rational.com

Asia Pacific
(Korea)

+82-2-556-9420 +82-2-556-9426 license@apac.rational.com
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Asia Pacific
(Mainland China,
Hong Kong, and
Taiwan)

+61-2-9419-0111 +61-2-9419-0123 license@china.rational.com

Europe
Middle East
Africa

+31 20 4546 200 +31 20 4546 202 license@europe.rational.com

North American
(East Coast) and
South America

800-433-5444
(toll free, USA only)

+1 (408) 863 4000

781-676-2460 license@rational.com

North America
(West Coast) and
Central America

800-433-5444
(toll free, USA only)

+1 (408) 863 4000

408-863-4001 license@rational.com

Your Location Telephone Facsimile E-mail
Contacting Rational Licensing Technical Support xvii
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1Before You Install – Client
This chapter explains the general tasks you must perform before you install Rational
Suite on a client in an initial installation and an upgrade installation. If you have
previously installed Rational products on your system, ensure that all Rational
products are upgraded to the same version. Because Rational tools share files and
components, a new installation can cause the older Rational products to stop working.
To ensure version compatibility, see Ensuring Version Compatibility on page 23 for our
recommendations and Upgrading from Earlier Versions of Rational Suite on page 79 for
an overview and procedures.

Table 1 directs you to information in this manual that can help you perform client
installation tasks.

Table 1 Client Installation Tasks

To See

License your Rational software. Client Licensing for Rational Software on page 23

Upgrade from earlier versions of
Rational software.

� Ensuring Version Compatibility on page 23
� Upgrading from Earlier Versions of Rational Suite on

page 79

Make sure your system meets the
minimum or recommended system
and software requirements.

Rational Suite System and Software Requirements on
page 25

Configure the Rational Suite Web
components.

Using Rational Suite Web Components on page 29

Prepare for installing Rational Rose,
RealTime, or Testing products as part
of your Rational Suite edition.

� Preparing for a Rational Rose Installation on page 29
� Preparing for a Rational Rose RealTime Installation on

page 29
� Preparing for a Rational Testing Products Installation

on page 30

Install optional features and software. Installing Optional Features and Software on page 28

Perform a silent installation. Performing a Silent Installation on page 30

Install a service release. Contact your system administrator.
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Rational Suite – Before You Install

This section provides the general requirements for installing a Rational Suite edition
on your system.

Before you start the Rational Software Setup program, make sure your system
administrator has set up the Rational Suite environment and given you the
information in the following worksheet. Skip features that either may not be included
in your Rational Suite or have not been configured by your system administrator.
Write notes in the right-hand column to help you remember this information.

Item Notes

Type of license you need to configure on
your client.

Which installation type to select in the
Setup program.

ClearCase LT Server name.

ProjectConsole Server name (optional).

ClearQuest Schema Repository.

RequisitePro Database.

Rational E-Mail Reader.

Rational License Server (floating licenses).

URL for ClearCase Web (optional).

URL for ClearQuest Web (optional).

URL for RequisiteWeb (optional).

Silent installation filename and location
(optional).

Earlier versions of Rational products on
your desktop.

Any additional software or optional
Rational Suite features you may need to
install. (For example, if your administrator
has set up an Oracle database, you must
install the Oracle Client software on your
system.)
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Client Licensing for Rational Software

You must have a license key installed and configured to run a Rational product. In the
Rational Software Setup program, a green check mark next to a Rational product
indicates you have a license key configured for that product. If you do not see a green
check mark next to the product you want to install, you may want to install a license
key before you install the product. Your system administrator should inform you that
you must either import a node-locked license key or specify a floating license server
in the License Key Administrator (LKAD).

To configure a license key during the Rational Software Setup program, click the
Configure Licenses button to launch the LKAD and the License Key Administrator
Wizard. Both tools provide online Help. If you do not install the license keys before
you install the product, the LKAD will appear at the end of the installation.

Rational Rose Uses a License Key for the Variant Installed

Rational Rose uses a license key for the variant of Rose that is installed, or a Rational
Suite key that includes that Rose variant. A Rational Rose variant cannot run with the
license key of a different Rose variant. For more information, see the Rational Suite
License Managment Guide.

License Linger Time

Unlike other Rational products, ClearCase LT licenses operate with a linger time of 30
minutes. The first time a user executes a ClearCase LT command that takes a license,
the license is allocated to that user for 30 minutes. This 30 minute “linger” interval is
re-started every time the user executes a ClearCase LT command that takes a license.
If the linger time expires before the user executes another ClearCase LT command, the
user's license is returned to the pool of available floating licenses, and the user has to
acquire another license to execute any more ClearCase LT commands. This linger
interval is set and cannot be changed.

In addition, if ClearCase LT checks out a suite license, the suite license also operates
with a 30 minute linger time. However, when other point products check out the suite
license, there is no linger time.

Ensuring Version Compatibility

When you have earlier versions of Rational products installed on a system, ensure
that all Rational products on that system are upgraded to the same version. Because
Rational tools share files and components, a new installation can cause the older
Rational products to stop working.
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The software on the clients are upgraded after software on the Rational Suite servers
have been upgraded. See Installing New Software on page 82 and Installing the Latest
Version of Rational Suite on page 86 for more information.

If the Rational Software Setup detects older products on the system, you will see the
Upgrade Compatibility dialog box. For each of the Rational products listed in the
Upgrade Compatibility dialog box, we strongly recommend that you remove the
software or remove the software and then upgrade sequentially.

❑ Upgrade it: Complete the installation. Upgrade all the products sequentially.
Before you upgrade the sofware from an earlier version, remove the software
listed in Installing New Software on page 82.

See Upgrading from Earlier Versions of Rational Suite on page 79 about the order
in which you must upgrade products and when you need to disconnect from
Rational datastores. Upgrading each product updates all necessary files,
registry entries, startup menu items, and shared components on your system.
Do not run any of the products until all have been upgraded because some of
the non-upgraded products may stop working.

You cannot perform upgrades with network installations. For more
information about network installations, see Selecting an Installation Type on
page 35.

Note: Do not attempt to install the Rational Shipping Server (ClearQuest
Multisite) on a system that has ClearCase LT Client installed.

❑ Remove it: Complete this installation. Remove the software using the
procedures in Removing Rational Suite – Client on page 41 or Removing Rational
Suite – Administrator on page 129.

� If ClearCase is on your system, remove ClearCase from the system before
you install ClearCase LT. If you continue with your installation of Rational
Suite on that system, the Setup program installs every Rational Suite point
product, except ClearCase LT client, on that system.

� If you have the Rational Shipping Server (ClearQuest Multisite) and
ClearCase on the same system, remove both products. If you remove only
one product, the other product will be corrupted.
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Rational Suite System and Software Requirements

Table 2 provides the recommendations and minimum requirements for operating
Rational Suite on your system. Although Rational testing products are installed on
desktops, see Before You Install – Administrator on page 45 for more information about
planning your testing environment.

Table 2 Desktop Requirements and Recommendations

Item Minimum Requirements and Recommendations

Supported Operating
Systems

� Windows 2000 Professional Service Pack 1 or 2
� Windows NT 4.0 Workstation Service Pack 6a
� Windows 98 Second Edition
� Windows ME
� Windows XP Professional

The following Rational Suite products either do not support, or
provide limited support for, Windows 98 and Windows ME. See
the product documentation for more information.
� Rational Suite DevelopmentStudio – RealTime Edition
� PureCoverage
� Purify
� Quantify
� Robot
� Test Agent
� TestManager

Hardware
Recommendations

� 500 MHz or higher
� 128 MB RAM or higher;

more memory generally improves responsiveness
� 3 GB or more free disk space on a single drive to accommodate

the Suite software and data.
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Disk Space to Install (all
components in each
Rational Suite edition)

� Enterprise Suite (no tutorial) – 1.6 GB
� AnalystStudio – 1.2 GB
� ContentStudio (Base Features) – 1.2 GB
� DevelopmentStudio – 1.5 GB
� DevelopmentStudio for UNIX (Windows Components only) –

809 MB
� DevelopmentStudio – RealTime Edition – 1.4 GB
� DevelopmentStudio – RealTime Edition for UNIX (Windows

Components only) – 809 MB
� Team Unifying Platform – 1.2 GB
� TestStudio – 1.3 GB
� Network installation: 2.6 GB space on network, 584 MB space

on systems

ClearCase LT Client File
Storage Space
Requirements

ClearCase LT needs enough disk space on the desktop to contain
all files loaded into snapshot views and all view-private files
added to the views. The amount of space required depends on the
number and sizes of the files in the views.

Microsoft Visual Basic � Visual Studio 6.0 Service Pack 4 or 5
� VS.Net Beta

Microsoft Visual C++ � Visual Studio 6.0 Service Pack 4 or 5
� VS.Net Beta

Microsoft Excel � Office 97 Service Release 2
� Office 2000 Service Release 1 or 2
� Office XP

Microsoft Word � Office 97 Service Release 2
� Office 2000 Service Release 1 or 2
� Office XP

Web Browsers on
Windows

� Internet Explorer 5.01 Service Pack 2, 5.5 (no Service Pack), 5.5
Service Pack 1, or 6.0.

� Netscape Navigator 4.72 to 4.78

Notes:
� ProjectConsole does not support Internet Explorer 5.01 Service

Pack 2.
� RequisitePro also supports Netscape 6.01.

Table 2 Desktop Requirements and Recommendations (continued)

Item Minimum Requirements and Recommendations
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Web Clients on
Non-Windows Platforms

ClearCase, ClearQuest, RequisitePro, Rational Unified Process,
Rose Web Publisher

Netscape 4.72 or higher, 6.01 (RequisitePro only)
� Solaris 2.6, 2.7, 2. 8
� HP-UX 10.2, 11, 11.11

Rose Add-Ins
� Rose Visual Basic
� Rose Visual C++
� Rose J

Microsoft Visual Basic (Visual Studio 6.0 Service Pack 4 or 5)

Microsoft Visual C++ (Visual Studio 6.0 Service Pack 4 or 5)

JDK 1.3 or any of the major Java IDEs

Java IDE Rose J supports the following Java IDEs. Use the JDK (IBM
version 1.3 or Sun Microsystems version 1.3) appropriate for your
IDE .
� VisualCafe in Studio 4 Professional Edition
� VisualCafe 4 Enterprise Edition
� VisualCafe 4 Expert Edition
� IBM VisualAge for Java Professional Edition
� IBM VisualAge for Java Enterprise Edition
� Forte for Java Internet Edition 2.0
� Forte for Java Community Edition 2.0
� JBuilder 4.0 Enterprise Edition
� JBuilder 4.0 Professional Edition
� JBuilder 4.0 Foundation Edition

Dual Boot Systems Rational Suite does not support dual boot systems where both
operating systems are on the same partition.

Rational Documentation Adobe Acrobat Reader 4.x or higher to read online PDF files.
Adobe Acrobat Reader is available for installation on the Rational
Solutions for Windows – Online Documentation CD.

Table 2 Desktop Requirements and Recommendations (continued)

Item Minimum Requirements and Recommendations
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Installing Optional Features and Software

The following features and software are optional installations. To upgrade these
features, perform a Custom Installation Type. Remove the previous version before
you perform the custom installation. Consult your project manager or administrator
to see if you may need these options.

Table 3 lists Rational Suite features that you can install using the Custom Installation
Type.

Language Support You can install Rational Suite on these international operating
systems: Simplified or Traditional Chinese, Dutch, French,
German, Hebrew, Italian, Japanese, Korean, and Swedish. All
displays, menus, controls, wizards, reports, and user
documentation are in US English.

If you have a Traditional Chinese, Dutch, Hebrew, or Korean
operating system, enter data (such as path names) in US English
or the ASCII character set.

If you have a Simplified Chinese, French, German, Italian,
Japanese, or Swedish operating system, enter data in US English
or the native language character set. Regional date, time,
currency, and numbering conventions are also supported for both
input and output.

Table 2 Desktop Requirements and Recommendations (continued)

Item Minimum Requirements and Recommendations

Table 3 Optional Rational Suite Features

Point Product Feature See

ClearQuest ClearQuest client Rational ClearQuest Installation
Guide

ProjectConsole ProjectConsole server and
agent

Rational ProjectConsole
Installation Guide

Rational Unified Process IBM e-Business content Rational Unified Process
Installation Guide

Rational Unified Process Microsoft Web Solutions
platform

Rational Unified Process
Installation Guide

Rational Unified Process Rational Process
Workbench

Rational Process Workbench
Getting Started Guide
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If you want to customize the defect reports that ship with ClearQuest, install Crystal
Reports on your system. To install Crystal Reports, use the Crystal Reports
instructions that come with the Crystal Reports CD-ROM in your Rational software
shipment.

Using Rational Suite Web Components

To use the Rational Suite Web applications on clients, custom installations are not
necessary. Simply install one of the Web browsers listed in Table 2, which starts on
page 25. To use ClearQuest Web and RequisiteWeb, you must also enable cookies in
your browser.

Preparing for a Rational Rose Installation

Here is an overview of tasks for installing Rose as part of your Rational Suite edition.

� Before you install Rational Rose as part of Rational Suite for the first time, back up
model and property files and restore path map variables. For instructions, see
either the Back Up Guidelines section in the Rational Rose Installation Guide or the
Getting Started section in the beginning of the Rational Rose Release Notes.

� When installing Rose as part of Rational Suite on Microsoft Windows NT 4.0 SP6a
or Windows 2000, Rose may not run until you add the Rational\Common directory
to your user path. Use the procedure in the File Location Guidelines section in the
Rational Rose Installation Guide to add the directory to your user path.

� If multiple variants of Rose are installed on a single Windows desktop, you can
only run the last variant installed. For example, if you install Rational Rose Modeler
Edition, and then install Rational Rose Professional J Edition, you can only run the
Rose Professional J variant.

Preparing for a Rational Rose RealTime Installation

Here is an overview of tasks for installing Rational Rose RealTime as part of your
Rational Suite edition.

� To generate and execute code with Rose RealTime, C++ compilers must be
installed on your system. See the Rational Rose RealTime Installation Guide for a list
of supported compilers and targets.

� To construct and execute UML models, test your Visual C++ environment. To help
you determine whether you have correctly installed and configured Visual C++ on
your system, see the Testing your Environment section in the Rational Rose RealTime
Installation Guide.
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� To deploy your model in a real-time operating system, see the Rational Rose
RealTime Installation Guide for information on referenced configurations.

Preparing for a Rational Testing Products Installation

Here is an overview of requirements for installing Rational testing products as part of
Rational Suite.

� Make sure that your system has TCP/IP installed.

� Verify that your system can communicate with other systems. (If you have any
problems, see your network administrator.)

� Rational Test Samples Setup is automatically installed in a Typical installation of
Rational Robot, TestStudio, and EnterpriseStudio. These files let you evaluate a
sample application, applets, and Rational project. See the Rational Testing Products
Installation Guide for a description of these files and for setup instructions.

� If SQA Suite 6.x is installed on your computer, you do not have to uninstall it. The
current version of Rational testing products and SQA Suite 6.x. can coexist because
they are installed in different directories.

Performing a Silent Installation

Your administrator may set up a silent installation so many users can perform
unattended installations of a Rational Software product with the same parameters. To
set up the silent installation, your administrator records a response.ini (silent
installation) file. The response.ini file directs the Rational Software Setup program to
install program files in a specific directory on your system. For more information
about setting up a silent installation, see Configuring and Performing Silent Installations
on page 112.

To run the silent installation on your system, your administrator gives you the
locations of the installation image and the installation directory (where the Rational
Software Setup program will install the files on your system). The installation
directory includes the response.ini file.

When the Setup program starts, you see installation dialog boxes, and if a restart is
required, your system restarts automatically. After the restart, you must log on
manually. The installer then re-launches automatically and finishes. When the
program finishes, you do not see an installation complete screen at the end. If your
administrator did not add a post-installation command to the response.ini file, you
must manually configure the licensing when the Setup program finishes.
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Running a Silent Installation

The following instructions describe the commands you need to run a silent
installation on your system.

Note: During a silent installation, you do not see messages about upgrade
compatibility. Therefore, before you run a silent installation, read and follow the
instructions about upgrade compatibility in Ensuring Version Compatibility on page 23.

Run the silent installation by entering the following commands on your system:

<installation source directory>\setup\rssetup.exe -silent

The installation source directory is the path to the folder on the network that contains
the rssetup executable, product files, and the response.ini file. The executable installs
the products specified in the response.ini file from the source directory to the
installation path. The default installation path is C:\Program Files\Rational\<Rational

products>.

The response.ini file contains an autocapture of a Rational Software Setup program
installation. In the autocapture, your administrator has selected the products and
options for you.

If you run the silent installation and the Setup program does not find a response.ini file
in the default location, it writes an error to C:\Program Files\Rational\RSSetup\Error.log.

Additional Commands for Different Name or Location

IIf your administrator changes the name or location of the response.ini file, use the
-response command alongside the -silent command on one line:

<installation source directory>\setup\rssetup.exe -silent -response:<path to response.ini file>

For example, your administrator recorded a response.ini file but renamed it
Enterprise.ini and moved it to D:\Responses. You would have to enter the following
path after -response:
<installation source directory>\setup\rssetup.exe -silent -response: d:\Responses\Enterprise.ini

The Enterprise.ini file in the d:\Responses directory directs the Setup program to install
program files to the installation path specified by your administrator in Enterprise.ini.

Troubleshooting an Unsuccessful Silent Installation

If a silent installation aborts, it probably means there are non-upgraded Rational
products on the system. Your administrator may have changed a command in the
response.ini file to stop the installation if it detects older Rational products on the
system.
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Manually install a product to find out which product(s) are on your system. Then
either remove the additional products or upgrade all the products sequentially. Speak
to your system administrator about the best way to upgrade the Rational products
sequentially.

Warning: Do not run any of the products until all have been upgraded because some
of the non-upgraded products may stop working.
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2Installing Rational Suite –
Client
This chapter describes the Rational Software Setup program. Use the Rational
Software Setup program for initial and upgrade installations of Rational Suite.

Some products within Rational Suite may need to be removed or may require backups
or test upgrades before you upgrade the Rational Suite. See Upgrading from Earlier
Versions of Rational Suite on page 79 for upgrade requirements.

Rational Software Setup Installation Requirements

The following general requirements are necessary to run the Rational Software Setup
program on your system.

1 You need to install Rational licenses to use Rational products. Install the Rational
license keys before or after you install Rational software.

2 The Rational Software Setup program requires that you install all Rational
products in the same directory. If you already have Rational products installed on
your system, the Setup program installs additional Rational products in the same
directory.

3 Make sure you have administrator privileges before installing Rational products.

To use the Rational Software Setup program on a Windows NT, 2000, or XP
system, you must have Windows administrator privileges on the local system. Log
in as one of the following users:

❑ Local administrator

❑ Member of the local administrator’s group

❑ Domain administrator who is a member of the local administrator’s group

4 Make sure that you have a current backup of your Registry and system directories.

5 Ensure that other programs are not running before you start the installation.

6 Turn off all virus protection software. These programs often run in the background
and interfere with the installation and file decompression process.
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7 Turn off any user interface managers or desktop environments that run on top of
Microsoft Windows.

8 Change to a standard VGA video driver while Rational Setup is running, or
disable video features such as virtual screens or screen switching.

9 Change to a standard mouse driver, or disable special mouse features that perform
tasks such as leaving pointer trails or changing pointer sizes.

10 Make certain that your system meets the minimum requirements.

11 The Rational Software Setup program uses C:\Program Files\Rational as the default
install path. The program installs software system files in the Windows directory
or Windows systems directory.

If your C:\ drive lacks sufficient free disk space, you may either specify another
drive during the installation procedure or make space available on the default
drive. The Software Setup program will report the amount of space required on all
drives for your installation.

Note: The Setup program installs Microsoft Core Components and some
additional files on the same drive as the operating system (often the C:\ drive),
even if you have specified an alternate drive for installation. These files can require
up to 395 MB of disk space on your hard drive.

Using the Rational Software Setup Program

The Rational Software Setup program installs Rational Software products, including
Rational Suite. Your Rational product shipment includes several Rational Solutions for
Windows installation CD-ROMs. Some Rational products may require you to insert
more than one installation disc into the drive during the Setup program.

1 Insert the Rational Solutions for Windows Disc 1 into your system’s CD-ROM drive.

The Rational Software Setup program starts automatically.

If autorun is disabled on your system, click Start > Run and enter
drive: \Setup.exe where drive is the letter of the CD-ROM drive.

2 The Rational Software Setup dialog box provides general information about the
software installation.

3 Choose the Rational Suite edition that you want to install from the Choose Product
dialog box. A green check mark next to a Rational product indicates you have a
license key configured for that product. If you do not see a green check mark next
to the product you want to install, you may want to install license keys before you
install the product.
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To configure a license key, click the Configure Licenses button to launch the
Rational License Key Administrator (LKAD) and the License Key Administrator
Wizard. If you do not install the license keys before you install the product, the
LKAD will appear at the end of the installation. Use the Rational License Key
Administrator Help or see the Rational Suite License Management Guide for
information about requesting and installing license keys.

4 Choose to accept or not accept the Rational Software license agreement in the
License Agreement dialog box.

❑ If you accept the license agreement, the Setup program continues.

❑ If you do not accept the license agreement, exit the Setup program by clicking
Finish or Cancel. When you exit from the Setup program, the Setup program
makes no changes to the system (unless you have used the Rational License
Key Administrator to install a license key file or use a Rational license server).

5 Select an installation type in the Select Configuration dialog box.

If you need to install a feature component of your Rational Suite edition, select
Custom and go to Step 6 on page 37. If you select any other installation type, see
Confirm Sufficient Free Space for the Installation on page 36 before you click Next.

Selecting an Installation Type

The Rational Software Setup program provides you with several installation
types, allowing you to install the configuration most appropriate for your system.
Table 4 describes each type.

Note: After you have chosen an installation type, you must use the same
installation type to install additional Rational products. For example, if you select
the network installation type to install Rational Suite AnalystStudio on your
system, you must use a network installation to install additional Rational products
on your system. To use a different installation option, remove the Rational
products from your system and select a new installation type to re-install the
products.

Table 4 Installation Types

Type Description

Typical � Installs the most commonly used features for a product.
� Use this option for standard installations.
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Confirm Sufficient Free Space for the Installation

If the amount of free space is less than the amount required, either:

� Exit from the Setup program and make more space available on the
specified disk, or

� Specify an alternate Install Path. Type the new path in the Install Path field or
use the Browse button to select a drive and directory.

Custom � Allows you to add or remove product features for installation.
� Defaults to all features in a Typical installation.
� Use this option to install Rational Suite feature components.

Compact � Installs a subset of the standard configuration. May omit optional
files, including online documentation or Help. To find out which
files will be installed, read the product’s release notes.

� Use this option for installations on systems with limited disk space.

Network � Installs the required files on your system to run the program from a
shared network folder. You need 584 MB disk space to accommodate
the shared system DLLs and local configuration settings the Setup
program installs on your system.

� Use this option to run a program from a centrally managed location.
� Map a drive on your local system to the source directory on the

network before you select this option. Select the Reconnect at
Logon option in the Windows Map Network Drive dialog box.

� This installation type is available to you when a system
administrator has copied and decompressed the product files to a
shared network folder. To set up a network installation, see
Configuring and Performing Network Installations on page 124.

You cannot perform the following tasks with this installation type:
� Perform upgrades
� Apply a Rational Service Release
� Install Rational ClearCase LT Server, Rational Test Enablers,

RequisiteWeb.

Warning: If ClearQuest MultiSite and the Rational Shipping Server
are part of your Suite edition, do not set up a network installation
of your Rational Suite. If you install the Rational Shipping Server
(ClearQuest MultiSite) and ClearCase LT Client on the same
system, the Rational Shipping Server does not work.

Table 4 Installation Types (continued)

Type Description
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If a Rational product has been previously installed with the Rational Software
Setup program, the Browse option and Install Path field are disabled. To enable
these options, remove all Rational products from the system, then reinstall the
products.

6 After you choose Custom, specify which features to install on your system in the
Choose Features dialog box. Click the + in front of products and features to expand
options, then select or clear options. There are dependencies between some
products that may force an installation option, even if you have cleared it.

7 You may see one or more of the following dialog boxes before you see the
Confirmation dialog box in Step 8 on page 39.

Update Shared Components

The Update Shared Components dialog box appears if the Setup program needs to
update shared files or components on your system. Click Next to have the Rational
Software Setup program install these files for you or Cancel to install these files
yourself.

Installing Shared Files

The Rational Software Setup program installs some shared components, which is
software provided by a company other than Rational. The Rational Suite Release
Notes includes a complete list of third-party components that are installed with
Rational Suite.

These components are potentially available to other applications on your system.
Setup installs the U.S. English version of these files. It does not overwrite newer
file versions.

If the Setup program needs to update shared components, it displays a list of the
shared components that require updates. The files listed must be installed on your
system before the installation can proceed.

Installing Files Yourself

In general, we recommend that you allow the installation procedure to install
shared files for you. In the following circumstances, you may want to install
the files yourself:

� You are using a U.S. English system, but installing new files may
invalidate your current environment. In this case, you need to determine
how to correct your environment so that you can run existing tools and
the Rational products you want to install.
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� Your site may mandate that you obtain shared files directly from the
source, for example, from Microsoft, rather than using files supplied by a
third party. Or your site may prohibit users from installing shared
components.

� You may want to install equivalent files that are localized to your
language. The check box, Replace files with newer versions in English,
is enabled when you have installed earlier versions of shared files that are
localized to a non-U.S. English language.

❑ If you select this check box, the U.S. English versions of the files
will replace your localized versions.

❑ If you clear this check box, you can save and print the list of files
that need to be updated. You will need to update the files
yourself.

� There may be a later version of the files available. Rational products
should work with the supplied version of shared files or any later
versions.

The Setup program does not recalculate the disk space required for your updated
selections.

Upgrade Compatibility

The Upgrade Compatibility dialog box appears if you have older Rational products
installed on your system. For each of the older products listed in the dialog box,
we strongly recommend that you do one of the following:

❑ Upgrade it: Complete the installation. Upgrade all products sequentially. See
Ensuring Version Compatibility on page 23 and Removing Earlier Versions of
Rational Suite on page 83 for a list of Rational products that you must remove
from your system before you can restart the Setup program and install current
versions of these products. For information about the order in which you
should upgrade and when you should disconnect from Rational datastores, see
Upgrading from Earlier Versions of Rational Suite on page 79. Upgrading each
product updates all necessary files, registry entries, startup menu items, and
shared components on your system.

Note: You cannot perform upgrades with network installations. For more
information about network installations, see Selecting an Installation Type on
page 35.

❑ Remove it: Complete this installation. Then see Removing Rational Suite – Client
on page 41 to remove the older Rational products from your system.
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8 The Confirmation dialog box displays the product features to be installed.

Warning: Interrupting the installation after you have confirmed the product
features to be installed may leave your system in an indeterminate state.

9 The Error Summary dialog box displays errors from the first part of the software
installation. If the installation is successful, this dialog box does not appear.

The Rational Software Setup program writes a log of installation messages in
<Install Path>\Rational\RSSetup\RSSetup.log.

The installation process may complete on your system or your system may require
a restart (Possible Restart Required on page 39).

10 Click Finish to exit from the Rational Software Setup program. The Installation
Complete screen provides links to the Rational Service Release web site and the
Rational Developer Network registration site. The check box to view the product
release notes is also enabled.

If you did not install the license keys before you installed the product, the Rational
License Key Administrator will launch at the end of the installation.

Possible Restart Required

If files required for the installation are in use during the Rational Software Setup
program, and if the program needs to install shared components on your system, the
Setup program may need to restart your system. After the restart, do the following:

1 Log on as the same administrator identity to complete the installation procedure. If
you do not log on as the same administrator identity, the installation does not
complete correctly.

The installation process completes on your system.

2 Click Finish to exit from the Rational Software Setup program. The Installation
Complete screen provides links to the Rational Service Release web site and the
Rational Developer Network registration site. The check box to view the product
release notes is also enabled.

If you did not install the license keys before you installed the product, the Rational
License Key Administrator will launch at the end of the installation.
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3Removing Rational Suite
– Client
This chapter describes the requirements and procedure for removing Rational Suite
from your system.

Before You Remove Rational Suite

This section provides general requirements for removing Rational Suite. It also
describes which components the Rational Software Setup program does or does not
remove from the system.

� If you plan to move the application to another system, first return the license key
file to your Rational Software account. To return a license key, use Rational
AccountLink (www.rational.com/accountlink), the online license management tool.
For more information about moving licenses or returning licenses, see the Rational
Suite License Management Guide.

� Removing an earlier version of Rational Suite does not delete the license key file,
project databases, and other files that you created while using Rational Suite. If
you plan to install an upgrade of Rational Suite to a different drive or use a new
installation path, back up these files and manually remove them. If you do not
remove them, the Rational Software Setup program may find these files and install
the appplication in the old location instead of the new location.

� To remove Rational Software products from a Windows NT, 2000, or XP system,
you must have Windows administrator privileges on the local system.

� Make sure that no one is using the application or any associated files. You cannot
remove files that are in use.

Removing Rational Suite

Use the Windows Add/Remove Programs control panel to select and remove Rational
Suite.
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4Before You Install –
Administrator
This chapter provides an overview of configuration tasks for installing Rational Suite
at your site. The following topics cover Rational Suite server installations. If you have
earlier versions of Rational products on your servers, ensure all Rational products on
each server are upgraded to the same version. For more information, see Ensuring
Version Compatibility on page 48 and Upgrading from Earlier Versions of Rational Suite on
page 79.

Table 6 directs you to information that can help you perform administrator
installation tasks.

Table 6 Administrator Installation Tasks

To See

License Rational software Administering Licenses for Rational Suite on
page 46

Upgrade from earlier versions of Rational
software

Ensuring Version Compatibility on page 48 and
Upgrading from Earlier Versions of Rational Suite
on page 79

Set up Rational Suite with Unified Change
Management

User’s and Administrator’s Guide – Unified Change
Management and Rational Suite on the Rational
Solutions for Windows – Online Documentation
CD-ROM.

Plan your Rational product integrations,
such as Rational RequisitePro and Rational
ClearQuest, and to plan how you will use
the Rational Administrator.

The Rational Administrator is automatically
installed with Rational Suite.

Rational Suite Administrator’s Guide on the
Rational Solutions for Windows – Online
Documentation CD-ROM.

Plan your Rational Suite environment Planning Your Rational Suite Environment on
page 50

Make sure the servers meets the minimum
or recommended system and software
requirements

Rational Suite System and Software Requirements
on page 51

Configure the Rational Suite Web
components

Configuring Web Servers – Administrator on
page 73
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Rational Suite – Before You Install

The following sections cover general requirements for planning your installation.

Administering Licenses for Rational Suite

You can request and install license keys before or after installing Rational products;
however, you must have a license key installed and configured to run a Rational
product. In the Rational Software Setup program, a green check mark next to a
Rational product indicates you have a license key configured for that product. If you
do not see a green check mark next to the product you want to install, you may want
to install a license key before you install the product. To configure a license key, click
the Configure Licenses button to launch the Rational License Key Administrator
(LKAD) and the License Key Administrator Wizard. Both tools provide Help. If you
do not install the license keys before you install the product, the LKAD will appear at
the end of the installation.

The Rational Suite License Management Guide describes the web-based license manager
AccountLink, Rational licensing terms, and the Rational License Key Administrator.
The Setup program installs the LKAD automatically with each point product within
Rational Suite. The License Management Guide also provides instructions for
requesting, installing, upgrading, and configuring floating and node-locked license
keys.

Note: If you plan to upgrade the Rational license server, and this server has other
Rational products installed on its system, remove the Rational products from the
system or upgrade the Rational products to the current release. Earlier versions of
Rational products may not work with an upgraded license server if they are on the
same system.

Licensing Rational ClearCase LT

This section describes ClearCase LT licensing.

Plan for a Rational testing environment Preparing for a Rational Testing Environment
Installation on page 58

Install Service Release Applying Service Releases – Administrator on
page 133

Table 6 Administrator Installation Tasks (continued)

To See
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� The ClearCase LT server and ClearCase LT client require separate floating licenses
when they are installed on separate systems. If you are evaluating ClearCase LT,
you need only one floating license because the the ClearCase LT server acts as both
server and client.

� Install the license server and ClearCase LT server on different systems.

For information about installing the Rational license server and license keys, see the
Rational Software license management manual.

License Linger Time

Unlike other Rational products, ClearCase LT licenses operate with a linger time of 30
minutes. The first time a user executes a ClearCase LT command that takes a license,
the license is allocated to that user for 30 minutes. This 30 minute “linger” interval is
re-started every time the user executes a ClearCase LT command that takes a license.
If the linger time expires before the user executes another ClearCase LT command, the
user's license is returned to the pool of available floating licenses, and the user has to
acquire another license to execute any more ClearCase LT commands. This linger
interval is set and cannot be changed.

In addition, if ClearCase LT checks out a suite license, the suite license also operates
with a 30 minute linger time. However, when other point products check out the suite
license, there is no linger time.

Licensing Rational Testing Products

This section describes the types of licenses you need to use Rational testing products.

� Rational Suite TestStudio requires floating licenses.

� To record GUI test scripts on multiple computers, you need to install Rational
Robot outside of Rational Suite on each computer. A separate node-locked license
is required for Robot-only installations.

Licensing Web Applications

Some of the Rational Web applications require license keys:

� To get full ClearQuest Web and RequisiteWeb access, install floating licenses. For
more information about installing floating license keys, see the Rational Software
license management guide.

� To use the ClearCase Web interface, use the same license type that you purchased
for the ClearCase LT server.
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Licensing Windows NT Components for DevelopmentStudio on
UNIX

To run the Windows NT components for DevelopmentStudio on UNIX, request a
floating license from AccountLink (www.rational.com/accountlink). When you receive the
permanent license key file from AccountLink, import the file on the Rational license
server.

� A UNIX license server can serve floating licenses to Windows and UNIX clients. To
set up a Rational license server on a UNIX system, see the DevelopmentStudio for
UNIX Installation Guide.

� A Windows license server can serve floating licenses to Windows and UNIX
clients. To set up a Rational license server on a Windows system, see the Rational
Software license management guide or use the Rational License Key
Administrator Help.

Ensuring Version Compatibility

When you have earlier versions of Rational products installed on a system, ensure
that all Rational products on that system are upgraded to the same version. Because
Rational tools share files and components, a new installation can cause the older
Rational products to stop working.

The software on the clients are upgraded after software on the Rational Suite servers
have been upgraded. See Installing New Software on page 82 and Installing the Latest
Version of Rational Suite on page 86 for more information.

If the Rational Software Setup detects older products on the system, you will see the
Upgrade Compatibility dialog box. For each of the Rational products listed in the
Upgrade Compatibility dialog box, we strongly recommend that you remove the
software or remove the software and then upgrade sequentially.

❑ Upgrade it: Complete the installation. Upgrade all the products sequentially.
Before you upgrade the sofware from an earlier version, remove the software
listed in Installing New Software on page 82.

See Upgrading from Earlier Versions of Rational Suite on page 79 about the order
in which you must upgrade products and when you need to disconnect from
Rational datastores. Upgrading each product updates all necessary files,
registry entries, startup menu items, and shared components on your system.
Do not run any of the products until all have been upgraded because some of
the non-upgraded products may stop working.
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You cannot perform upgrades with network installations. For more
information about network installations, see Selecting an Installation Type on
page 35.

Note: Do not attempt to install the Rational Shipping Server (ClearQuest
Multisite) on a system that has ClearCase LT Client installed.

❑ Remove it: Complete this installation. Remove the software using the
procedures in Removing Rational Suite – Client on page 41 or Removing Rational
Suite – Administrator on page 129.

� If ClearCase is on your system, remove ClearCase from the system before
you install ClearCase LT. If you continue with your installation of Rational
Suite on that system, the Setup program installs every Rational Suite point
product, except ClearCase LT client, on that system.

� If you have the Rational Shipping Server (ClearQuest Multisite) and
ClearCase on the same system, remove both products. If you remove only
one product, the other product will be corrupted.
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Planning Your Rational Suite Environment

To help you plan your Rational Suite environment, you need to determine which
systems will be server systems. Servers need to be highly available, and may need
extra memory and disk space. Table 7 describes the types of servers you may need.
You will need some of the same servers for installing Rational Suite
DevelopmentStudio on UNIX (Windows NT Components).

Table 7 Servers Used with Rational Suite

Type of Server Description

License server If you use floating licenses, you need to set up a server to administer
the licenses. For more information, see the Administering Licenses for
Rational Software manual or the Rational License Key Administrator
Help.

Database server � If you are using commercial databases with Rational Suite
products, you probably want to install those databases on
dedicated systems.

� Microsoft Access Runtime is automatically installed when you
install at least one Rational Suite product on your system. Sybase
SQL Anywhere is available on the Rational Solutions for Windows
installation discs, but it is configured to work only with Rational
products.

� The following Rational tools require databases: ClearQuest,
ProjectConsole, RequisitePro, and Rose Data Modeler. For more
information, see Preparing for a Rational ClearQuest Server
Installation on page 55, Preparing for a Rational ProjectConsole
Installation on page 55, Preparing for a Rational RequisitePro Server
Installation on page 58, and Preparing for a Rational Rose Data
Modeler Installation on page 58.

Web server � Some Rational tools include a Web component. Rational Suite Web
server components give users who do not have Rational Suite on
their systems the opportunity to access project data. You can set
up a Web server for these tools: ClearCase LT, ClearQuest,
ProjectConsole, RequisitePro, and Manual Test Web. For more
information, see Configuring Web Servers – Administrator on
page 73.

� The Rational Unified Process and Rose Web Publisher are also
Web applications, but you do not have to install Web server
components or configure Web server software to use them.

ClearCase LT server ClearCase LT is a client/server product. For guidelines about
installing a ClearCase LT server system, see the Rational ClearCase LT
Installation Guide.
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Rational Suite System and Software Requirements

Table 8 provides the recommendations and minimum requirements for operating
Rational Suite servers or administrator systems.

ClearQuest
administrator’s system

In addition to the ClearQuest Web server and database server, you
need to designate one system as the administrator’s system. For
more information, see Preparing for a Rational ClearQuest Server
Installation on page 55.

ProjectConsole Agent An agent is a system that provides the ProjectConsole server access
to project data from Rational Projects or Microsoft Project. It collects
artifacts from these data repositories for the server and stores the
artifacts in a metrics warehouse.

Table 7 Servers Used with Rational Suite (continued)

Type of Server Description

Table 8 Server Requirements and Recommendations

Item Minimum Requirements and Recommendations

Supported Operating
Systems

� Whistler (also known as Windows 2002 or Windows.NET)
Advanced Server Beta RC2

� Windows 2000 Server Service Pack 1 or 2
� Windows 2000 Advanced Server Service Pack 1 or 2
� Windows NT 4.0 Server Service Pack 6a

Hardware
Recommendations

� 500 MHz or higher
� 256 MB RAM or higher;

more memory generally improves responsiveness
� ClearCase LT server – 128 MB RAM or higher
� 2 x physical memory is the recommended swap space
� 2 GB or more free disk space on a single drive to accommodate

the Suite software and data.

ClearCase LT Server
File Storage Space
Requirements

� ClearCase LT needs enough disk space on the server to contain
the files and databases under source control. The amount of
space required depends on the characteristics and use of the
VOBs and views.

� In addition to enough free disk space to load ClearCase LT
server, the server needs 0.5 to 1.0 MB for each user who will use
the ClearCase Web interface through the ClearCase LT server.
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Application Servers � WebSphere 3.5 Fix Pack 3.
� WebLogic 6.0 (WebLogic client software also required).

Notes: Rational Quality Architect also supports:
�WebSphere 4.x , Advanced Edition
�WebLogic 5.1 or higher
�Sun J2EE Reference Server

Hosted Development
Systems (remote
sessions)

ClearQuest, RequisitePro, Robot, Rose, SoDA, and Test Manager
support hosted development on these platforms:
� Citrix MetaFrame.
� Windows NT 4.0 Terminal Server Service Pack 6a. ClearQuest

does not support Windows Terminal Server on Windows NT.
� Windows 2000 Advanced Server Service Pack 1 or 2.

Note: ClearCase supports hosted development on the above
platforms except on Citrix MetaFrame.

Web Servers � IIS 4 on Windows NT.
� IIS 5 on Windows 2000.
� ClearCase also supports Apache and Netscape.
� Manual Test Web Execution: We recommend that you use

Windows 2000 Server, Windows 2000 Advanced Server, or
Windows NT 4.0 Server as the Web Server platform. However,
if you use Windows 98, Windows 95, or Windows NT 4.0,
install Microsoft Personal Web Server (PWS) from the Windows
NT 4.0 Option Pack.

Web Servers on
Non-Windows
Platforms

ClearCase supports:
Apache on Solaris 2.9 or higher, HP-UX 11.11 or higher, Red Hat
Linux 7.

Sybase SQL Anywhere
Server

Sybase SQL Anywhere 5.5.05 is available on the Rational Solutions
for Windows installation discs. It is configured to work only with
Rational products.

Table 8 Server Requirements and Recommendations (continued)

Item Minimum Requirements and Recommendations
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Preparing for a Rational ClearCase LT Server Installation

Here is an overview of tasks for installing ClearCase LT server. See the Rational
ClearCase LT Installation Guide for detailed procedures.

Note: If you have installed ClearCase on any system that you intend to use as a
ClearCase LT server or client, you must remove ClearCase on those systems before
you install ClearCase LT.

Databases � IBM DB2 Universal Database 7.1 Service Pack 2 or 3
IBM DB2 OS390 7.1 Service Pack 2 or 3

� Microsoft Access 2000, 2002
� Microsoft SQL Server 7.0 Service Pack 3 or 2000 Service Pack 1
� Oracle server 8.1.6, 8.1.7

Oracle client 8.1.6, 8.1.7
� Sybase SQL Anywhere 5.5.05

Notes:
� Rational ClearQuest also supports Oracle 8.0.5.
� Rational ProjectConsole does not support Sybase SQL

Anywhere.
� Rational RequisitePro does not support IBM DB2 or Sybase

SQL Anywhere.

Dual Boot Systems Rational Suite does not support dual boot systems where both
operating systems are on the same partition.

Rational
Documentation

Adobe Acrobat Reader 4.x or higher to read online PDF files.
Adobe Acrobat Reader is available for installation on the Rational
Solutions for Windows – Online Documentation disc.

Language Support You can install Rational Suite on these international operating
systems: Simplified or Traditional Chinese, Dutch, French,
German, Hebrew, Italian, Japanese, Korean, and Swedish. All
displays, menus, controls, wizards, reports, and user
documentation are in US English.

If you have a Traditional Chinese, Dutch, Hebrew, or Korean
operating system, enter data (such as path names) in US English
or the ASCII character set.

If you have a Simplified Chinese, French, German, Italian,
Japanese, or Swedish operating system, enter data in US English
or the native language character set. Regional date, time, currency,
and numbering conventions are also supported for both input and
output.

Table 8 Server Requirements and Recommendations (continued)

Item Minimum Requirements and Recommendations
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1 ClearCase LT is a client/server product. To use a ClearCase LT client, a
ClearCase LT server must be installed in the same network domain as the clients.

❑ The ClearCase LT server requires a separate installation. To select a ClearCase
LT server system, see the Rational ClearCase LT Installation Guide for
requirements.

❑ A ClearCase LT client can access only one server.

2 For optimal performance, we strongly recommend installing the ClearCase LT
server on a dedicated system. However, if you are evaluating ClearCase LT or
working in a small team, you can install ClearCase LT server and Rational Suite on
the same system.

❑ To install the ClearCase LT server and Rational Suite on the same system, install
the ClearCase LT server first. When you install Rational Suite on the same
system afterward, the Rational Software Setup program excludes the ClearCase
LT client software. In a typical Rational Suite installation, the ClearCase LT
client is included.

❑ To evaluate ClearCase LT, use only the ClearCase LT server because the server
includes client software.

3 The systems on which you plan to install ClearCase LT must be members of a
Windows NT domain, and all users who will use ClearCase LT must have
accounts in a Windows NT domain.

4 Designate one domain group as the ClearCase Users Group. When you install
ClearCase LT server, you need to be a member of the ClearCase Users Group as
well as have administrator privileges to run the Server Setup Wizard at the end of
the installation (or after the restart). If you are not a member of the ClearCase
Users Group when you install ClearCase LT server, you will have to log out and
log in again as a member of the ClearCase Users Group to run the Server Setup
Wizard.

5 If you anticipate many users will access a single VOB more or less simultaneously,
install Windows NT or Windows 2000 server software on your ClearCase LT
server. A maximum of 10 systems can access a Windows NT or Windows 2000
Workstation simultaneously by means of file-system mounts or Uniform Naming
Convention (UNC).

6 You can install ClearCase LT server on any UNIX platform that ClearCase LT
supports. For a list of platforms that ClearCase LT supports, see the Rational
ClearCase LT Release Notes. For more information about interoperation between
Windows and UNIX, see the Rational ClearCase LT Administrator’s Guide.
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7 The Server Setup Wizard appears immediately after you install ClearCase LT
server if you have logged in using the correct permissions. Refer to Configuring the
Rational ClearCase LT Server on page 69 for an overview of Server Setup and
operating environment requirements.

Preparing for a Rational ClearQuest Server Installation

Here is an overview of asks for installing ClearQuest as part of your Rational Suite
edition. For detailed procedures, see the Rational ClearQuest Installation Guide.

Note: For improved performance, security, and reliability, we recommend that you
place the database server and the Web server on two different systems, each with its
software installed onto a Windows NT File System (NTFS) partition.

1 Set up an empty server database for the ClearQuest schema repository and at least
one empty database for the ClearQuest user database.

For guidelines on which type of database software would meet your needs and for
procedures for setting up the database software, see the Rational ClearQuest
Installation Guide.

2 Select a system that has extra memory and disk space to become the ClearQuest
administrator’s system.

3 If you or other users want to customize the defect reports that ship with
ClearQuest, install Crystal Reports on the ClearQuest administrator’s system and
client systems. To install Crystal Reports, use the Crystal Reports installation
directions that come with the separate Crystal Reports CD-ROM in your Rational
software shipment.

Preparing for a Rational ProjectConsole Installation

The ProjectConsole installation consists of a ProjectConsole server (server), a
ProjectConsole agent (agent), and a metrics warehouse. The server is a Web server that
serves project data from the ProjectConsole Web site to client browsers. The
ProjectConsole server can also act as an agent for collecting artifacts from Rational
tools. Optionally, you can set up additional systems as agents to collect data. In
addition to collecting artifacts, an agent provides the server access to project data
stored in the metrics warehouse. This stored project data is displayed on the
ProjectConsole Web site. The metrics warehouse is set up on the ProjectConsole server
system. However, depending on the commercial database you use, you can set up the
metrics warehouse on a separate system from the ProjectConsole server.

For each complete ProjectConsole installation, you can use only one system as the
server. However, you can use any number of systems as agents.
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ProjectConsole Server Software

The ProjectConsole server software consists of the following:

� ProjectConsole Dashboard Server

� ProjectConsole Administrator Java applet

� ProjectConsole Dashboard Designer Java applet

� ProjectConsole Dashboard Java applet

� ProjectConsole Presentation Server

� ProjectConsole Document Server

� ProjectConsole XML Server (Web page generator)

� Dashboard metrics warehouse

Note: A physical database can reside on a separate database server machine.

ProjectConsole Agent Software

The agent software that you install on the server system and, optionally, agent
systems, collects artifacts from Rational software development programs, as well as
from Microsoft Project. (Because the server has the agent software installed, it can also
act as an agent.) Agents can extract artifacts from the data repositories of the
following products:

� Rational ClearCase

� Rational ClearQuest

� Rational Coverage

� Rational Purify

� Rational RequisitePro

� Rational Rose

� Microsoft Project

To collect artifacts from one of these products, a system must have the product, as well
as the agent software, installed. For example, to collect project defect data from
Rational ClearQuest, an agent must have Rational ClearQuest installed.
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Metrics Warehouse

After the agent(s) extract artifacts from development tools, ProjectConsole stores the
artifacts in the metrics warehouse on the server so that they can be displayed on the
ProjectConsole Web site. After you install and set up ProjectConsole on the server,
create a schema repository database and a warehouse database for the metrics warehouse
on the server. The warehouse database is the physical database for the metrics
warehouse. The schema repository database is the master database for the metrics
warehouse. Then create the metrics warehouse on the ProjectConsole server.

Note: You can create the schema repository and warehouse databases either before or
after you install ProjectConsole on the server. However, you must create them before
you create the metrics warehouse.

For information about creating the schema repository and warehouse databases for
the metrics warehouse, see Chapter 2, Preparing Vendor Databases in the Rational
ProjectConsole Installation Guide.

To set up ProjectConsole:

1 Create the schema repository and warehouse databases for the metrics warehouse.

Note: If you decide to configure Oracle or DB2 databases on a system other than
the ProjectConsole server, install and configure the Oracle or DB2 client software
on the ProjectConsole server.

2 Use the Custom installation type to install the ProjectConsole server (and agent)
software on the server system. Although it is not required, we recommend that
you install Rational Suite Enterprise on the server if you plan to use the agent to
collect data from several Rational point products.

We also recommend that you install the software on a dedicated system.

3 Configure the server software.

4 Create the metrics warehouse.

5 Use the Custom installation type to install the ProjectConsole agent software on
agent system(s). This is optional. If you plan to use an agent to collect data from
several Rational products, we recommend that you install Rational Suite
Enterprise on the agent so that it can collect data from all of the supported Rational
tools.

6 Configure the agent software.
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For information about configuring ProjectConsole software on the server and agent
systems, and about creating the metrics warehouse, see Chapter 3, Installing Rational
ProjectConsole in the Rational ProjectConsole Installation Guide.

Preparing for a Rational RequisitePro Server Installation

Before installing RequisitePro, determine which database type you will use with
RequisitePro Projects. RequisitePro can be used with Oracle, Microsoft SQL Server,
and Microsoft Access databases. Refer to Oracle or Microsoft documentation for
information on installing Oracle or Microsoft SQL Server. If you are using an Oracle
database, you must also install the Oracle Client software on the client systems.

For more information, see the Rational RequisitePro Installation Guide for detailed
procedures.

Preparing for a Rational Rose Data Modeler Installation

To use Rose Data Modeler, see Table 8 on page 47 for the supported databases and
follow the database vendor’s documentation for configuration instructions. The user
guide for Rose Data Modeler does not provide database configuration procedures.

Preparing for a Rational Testing Environment Installation

Here is an overview of tasks for installing Rational testing products as part of your
Rational Suite edition. For more information about Rational testing products and
features, see the Rational Testing Products Installation Guide.

1 Previous versions of Rational LoadTest and Rational Suite PerformanceStudio will
not work with testing products from this release. You must remove them first.

2 If SQA Suite 6.x is installed on your computer, you do not have to uninstall it. The
current version of Rational testing products and SQA Suite 6.x. can coexist because
they are installed in different directories.

3 Make sure that all computers have TCP/IP installed. If you have updates to your
network software that you have not installed, be sure to install the upgrades.

4 Verify that the Windows systems are communicating with each other.

5 Rational Test Samples Setup is automatically installed in a Typical installation of
Rational Robot, TestStudio, and EnterpriseStudio. These files let you evaluate a
sample application, applets, and Rational project.

6 Determine the role each system will play in testing—whether it will be a Local
(Rational Suite) or an Agent system. For a description of these roles, see the
Rational Testing Products Installation Guide.
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a After you install the Rational Suite on a Local system, use the Rational Software
Setup program to install Rational Test Agent on Agent systems. To do this,
select Rational Test Agent in the Choose Product dialog box.

b To install Test Agent software on a UNIX system, see the Rational Testing
Products Installation Guide.

Note: The same version of Rational testing software must be installed on the Local
and Agent computers; otherwise, they will not work together.

7 Determine the kind of network you will be using, either Ethernet or Token Ring.
You need this information when you install the Rational Test network driver. For
more information, see “Installing the Rational Test Network Driver” in the Rational
Testing Products Installation Guide.

8 Use the Rational Administrator to create your test datastores. The Rational
Administrator is automatically installed with Robot and TestManager. When you
create a test datastore in the Rational Administrator, you can use either Microsoft
Access or Sybase SQL Anywhere to store your test data. Microsoft Access is the
default database. If you select Sybase SQL Anywhere, install it from the Rational
Solutions for Windows installation disc.

❑ See the Rational Suite Administrator’s Guide for more information about
configuring a Rational Suite environment.

❑ See the Rational Testing Products Installation Guide for more information about
configuring Sybase SQL Anywhere for the Rational Administrator.
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Table 9 lists the additional components that you may need to install for Rational
testing products that are part of Rational Suite.

Table 9 Additional Installations

To Install

Test ActiveX controls, Java applets,
Oracle Forms, and Visual Basic
applications

Rational Test Enablers:
� Rational ActiveX Test Control
� Rational Test Java Enabler
� Rational Test Oracle Forms Enabler
� Rational Test Visual Basic Enabler

Record sessions over a network Rational Test network driver

Determine the kind of network you will be
using, either Ethernet or Token Ring. You need
to know this information to install the network
driver.

Record GUI test scripts on multiple
computers

Rational Robot as a standalone product on each
computer
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5Installing Rational Suite –
Administrator
This chapter describes the Rational Software Setup program. Use the Rational
Software Setup program for initial and upgrade installations of Rational Suite on
server systems.

Some products within Rational Suite may need to be removed or may require backups
or test upgrades before you upgrade the Rational Suite. See Upgrading from Earlier
Versions of Rational Suite on page 79 for upgrade requirements.

Rational Software Setup Installation Requirements

The following general requirements are necessary to run the Rational Software Setup
program on your system.

1 You need to install Rational licenses to use Rational products. Install the Rational
license keys before or after you install Rational software.

2 The Rational Software Setup program requires that you install all Rational
products in the same directory. If you already have Rational products installed on
your system, the Setup program installs additional Rational products in the same
directory.

3 Make sure you have administrator privileges before installing Rational products.

To use the Rational Software Setup program on a Windows NT, 2000, or XP
system, you must have Windows administrator privileges on the local system. Log
in as one of the following users:

❑ Local administrator

❑ Member of the local administrator’s group

❑ Domain administrator who is a member of the local administrator’s group

4 Make sure that you have a current backup of your Registry and system directories.

5 Ensure that other programs are not running before you start the installation.

6 Turn off all virus protection software. These programs often run in the background
and interfere with the installation and file decompression process.
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7 Turn off any user interface managers or desktop environments that run on top of
Microsoft Windows.

8 Change to a standard VGA video driver while Rational Setup is running, or
disable video features such as virtual screens or screen switching.

9 Change to a standard mouse driver, or disable special mouse features that perform
tasks such as leaving pointer trails or changing pointer sizes.

10 Make certain that your system meets the minimum requirements.

11 The Rational Software Setup program uses C:\Program Files\Rational as the default
install path. The program installs software system files in the Windows directory
or Windows systems directory.

If your C:\ drive lacks sufficient free disk space, you may either specify another
drive during the installation procedure or make space available on the default
drive. The Software Setup program will report the amount of space required on all
drives for your installation.

Note: The Setup program installs Microsoft Core Components and some
additional files on the same drive as the operating system (often the C:\ drive),
even if you have specified an alternate drive for installation. These files can require
up to 395 MB of disk space on your hard drive.

Using the Rational Software Setup Program

The Rational Software Setup program installs Rational Software products, including
Rational Suite. Your Rational product shipment includes several Rational Solutions for
Windows installation CD-ROMs. Some Rational products may require you to insert
more than one installation disc into the drive during the Setup program.

1 Insert the Rational Solutions for Windows Disc 1 into your system’s CD-ROM drive.

The Rational Software Setup program starts automatically.

If autorun is disabled on your system, click Start > Run and enter
drive: \Setup.exe where drive is the letter of the CD-ROM drive.

2 The Rational Software Setup dialog box provides general information about the
software installation.

3 Choose the edition of Rational Suite that you want to install from the Choose
Product dialog box. A green check mark next to a Rational product indicates you
have a license key configured for that product. If you do not see a green check
mark next to the product you want to install, you may want to install license keys
before you install the product.
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To configure a license key, click the Configure Licenses button to launch the
Rational License Key Administrator (LKAD) and the License Key Administrator
Wizard. If you do not install the license keys before you install the product, the
LKAD will appear at the end of the installation. Use the Rational License Key
Administrator Help or see the Rational Suite License Management Guide for
information about requesting and installing license keys.

4 Choose to accept or not accept the Rational Software license agreement in the
License Agreement dialog box.

❑ If you accept the license agreement, the Setup program continues.

❑ If you do not accept the license agreement, exit the Setup program by clicking
Finish or Cancel. When you exit from the Setup program, the Setup program
makes no changes to the system (unless you have used the Rational License
Key Administrator to install a license key file or use a Rational license server).

5 Select an installation type in the Select Configuration dialog box.

❑ If you need to install the feature component of a Rational Suite, select Custom
and go to Step 6 on page 66. Table 10 lists Rational Suite servers that you can
install using the Custom Installation Type.

❑ To enable all installation type options, remove all Rational Software products
from the system and then restart the Setup program.

❑ If you select any other installation type, see Confirm Sufficient Free Space for the
Installation on page 65 before you click Next.

Table 10 Rational Suite Features

Rational Suite Point
Product

Feature Where You Need to Install
Feature

ClearQuest ClearQuest administrator ClearQuest administrator’s
system

ProjectConsole Server

Agent

ProjectConsole server

ProjectConsole Agent ProjectConsole agent
(optional)

RequisitePro Database configuration
scripts

Database server
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Selecting an Installation Type

The Rational Software Setup program provides you with several installation
types, allowing you to install the configuration most appropriate for the Rational
Suite server. Table 11 describes each type.

Note: After you have chosen an installation type, you must use the same
installation type to install additional Rational products. For example, if you select
the network installation type to install Rational Suite AnalystStudio on the server,
you must use a network installation to install additional Rational products. To use
a different installation option, remove the Rational products from the system and
select a new installation type to re-install the products.

Table 11 Installation Types

Type Description

Typical � Installs the most commonly used features for a product.
� Use this option for standard installations.

Custom � Allows you to add or remove product features for installation.
� Defaults to all features in a Typical installation.
� Use this option to install Web server components and other Rational

Suite feature components. See Table 10 on page 63 for a feature list.

Compact � Installs a subset of the standard configuration. May omit optional
files, including online documentation or Help. To find out which
files will be installed, read the product’s release notes.

� Use this option for installations on systems with limited disk space.
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Confirm Sufficient Free Space for the Installation

If the amount of free space is less than the amount required, either:

� Exit from the Setup program and make more space available on the
specified disk, or

� Specify an alternate Install Path. Type the new path in the Install Path field or
use the Browse button to select a drive and directory.

If a Rational product has been previously installed with the Rational Software
Setup program, the Browse option and Install Path field are disabled. To enable
these options, remove all Rational products from the system, then reinstall the
products.

Network � Installs the required files on the server to run the program from a
network location. You need 584 MB disk space to accommodate the
shared system DLLs and local configuration settings the Setup
program installs.

� Use this option to run a program from a centrally managed location.
� Instruct users to map a drive on the local system to the source

directory on the network before they select this option in the Setup
program. Select the Reconnect at Logon option in the Windows
Map Network Drive dialog box.

� Use this installation type when you have copied and decompressed
the product files to a network directory. To set up a network
installation, see Configuring and Performing Network Installations
on page 124.

You cannot perform the following tasks with this installation type:
� Perform upgrades
� Apply a Rational Service Release
� Install Rational ClearCase LT Server, Rational Test Enablers, and

RequisiteWeb

Warning: If ClearQuest MultiSite and the Rational Shipping Server
are part of the Suite edition, do not set up a network
installation of Rational Suite. If you install the Rational
Shipping Server (ClearQuest MultiSite) and ClearCase LT
Client on the same system, the Rational Shipping Server
does not work.

Table 11 Installation Types (continued)

Type Description
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6 After you choose Custom, specify which features to install on your system in the
Choose Features dialog box. Click the + in front of products and features to expand
options, then select or clear options. There are dependencies between some
products that may force an installation option, even if you have cleared it.

Note: Before you click Next, see Confirm Sufficient Free Space for the Installation on
page 65.

7 You may see one or more of the following dialog boxes before you see the
Confirmation dialog box in Step 8 on page 68.

Update Shared Components

The Update Shared Components dialog box appears if the Setup program needs to
update shared files or components on your system. Click Next to have the
Rational Software Setup program install these files for you or Cancel to install
these files yourself.

Installing Shared Files

The Rational Software Setup program installs some shared components, which is
software provided by a company other than Rational. The Rational Suite Release
Notes includes a complete list of third-party components that are installed with
Rational Suite.

These components are potentially available to other applications on your system.
Setup installs the U.S. English version of these files. It does not overwrite newer
file versions.

If the Setup program needs to update shared components, it displays a list of the
shared components that require updates. The files listed must be installed on your
system before the installation can proceed.

Installing Files Yourself

In general, we recommend that you allow the installation procedure to install
shared files for you. In the following circumstances, you may want to install
the files yourself:

� You are using a U.S. English system, but installing new files may
invalidate your current environment. In this case, you need to determine
how to correct your environment so that you can run existing tools and
the Rational products you want to install.
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� Your site may mandate that you obtain shared files directly from the
source, for example, from Microsoft, rather than using files supplied by a
third party. Or your site may prohibit end users from installing shared
components.

� You may want to install equivalent files that are localized to your
language. The check box, Replace files with newer versions in English,
is enabled when you have installed earlier versions of shared files that are
localized to a non-U.S. English language.

❑ If you select this check box, the U.S. English versions of the files
will replace your localized versions.

❑ If you clear this check box, you can save and print the list of files
that need to be updated. You will need to update the files
yourself.

� There may be a later version of the files available. Rational products
should work with the supplied version of shared files or any later
versions.

The Setup program does not recalculate the disk space required for your updated
selections.

Upgrade Compatibility

The Upgrade Compatibility dialog box appears if you have older Rational products
installed on the system. For each of the older products listed in the dialog box, we
strongly recommend that you do one of the following:

❑ Upgrade it: Complete the installation. See Ensuring Version Compatibility on
page 48 and Removing Earlier Versions of Rational Suite on page 83 for a list of
Rational products that you must remove from the system before you can restart
the Setup program and install current versions of products. For complete
upgrade instructions for servers, datastores, and clients, see the chapter
Upgrading from Earlier Versions of Rational Suite on page 79. Upgrading each
product updates all necessary files, registry entries, startup menu items, and
shared components on your system.

Note: You cannot perform upgrades with network installations. For more
information about network installations, see Selecting an Installation Type on
page 64.

❑ Remove it: Complete this installation. Then see Removing Rational Suite –
Administrator on page 129 to remove the older Rational products from your
system.
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8 The Confirmation dialog box displays the product features to be installed.

Warning: Interrupting the installation after you have confirmed the product
features to be installed may leave your system in an indeterminate state.

9 The Error Summary dialog box displays errors from the first part of the software
installation. If the installation is successful, this dialog box does not appear.

The Rational Software Setup program writes a log of installation messages in
<Install Path>\Rational\RSSetup\RSSetup.log.

The installation process may complete on your system or your system may require
a restart (Possible Restart Required on page 68).

10 Click Finish to exit from the Rational Software Setup program. The Installation
Complete screen provides links to the Rational Service Release web site and the
Rational Developer Network registration site. The check box to view the product
release notes is also enabled.

If you did not install the license keys before you installed the product, the Rational
License Key Administrator will launch at the end of the installation.

Possible Restart Required

If files required for the installation are in use during the Rational Software Setup
program, and if the program needs to install shared components on your system, the
Setup program may need to restart your system. After the restart, do the following:

1 Log on as the same administrator identity to complete the installation procedure. If
you do not log on as the same administrator identity, the installation does not
complete correctly.

The installation process completes on your system.

2 Click Finish to exit from the Rational Software Setup program. The Installation
Complete screen provides links to the Rational Service Release web site and the
Rational Developer Network registration site. The check box to view the product
release notes is also enabled.

If you did not install the license keys before you installed the product, the Rational
License Key Administrator will launch at the end of the installation.
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6Configuring Rational
Servers – Administrator
This chapter provides an overview of configuration tasks you must perform after
you’ve installed the following Rational Suite servers: ClearCase LT, ClearQuest,
ProjectConsole agent (optional) and RequisitePro.

Configuring the Rational ClearCase LT Server

After you install ClearCase LT server, configure the server, import existing files into
ClearCase LT control, and make adjustments to the operating environment. For more
information about each of the following tasks, see the ClearCase LT installation
manual.

1 The Server Setup Wizard runs automatically at the end of a ClearCase LT server
installation if you ran the Rational Software Setup as a user who is a member of the
local administrator’s group and who is also a member of the ClearCase users
group. To install Rational Suite (which includes ClearCase LT client) on client
systems before you configure the ClearCase LT server, cancel the wizard and run it
later. See the ClearCase LT installation manual for more information.

2 To import files and directories or convert files from another configuration
management system into ClearCase version control, use the Import Wizard option
in the Server Setup Wizard. The Import Wizard places these files and directories in
the VOB that the Server Setup creates.

3 After you set up the ClearCase LT server, you can perform administrative tasks on
the VOB and view storage directories. See the Rational ClearCase LT Administrator’s
Guide for more information.

4 Make these adjustments to the client and server systems:

a Set the CLEARCASE_PRIMARY_GROUP environment variable for each user.

b Reset the language environment on the client to match the environment on the
server if one of the language settings uses single-byte encoding and the other
uses double- or multi-byte encoding.

For more information, see the Rational ClearCase LT Installation Guide.

5 Instruct each user to create views to access data on the ClearCase LT server.
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Configuring the Rational ClearQuest Servers

The following overview assumes that you have set up empty vendor databases and
that you have installed ClearQuest on the administrator’s system. For more
information about the following tasks, see the Rational ClearQuest Installation Guide.

1 On the ClearQuest administrator’s system, performing the following tasks:

a Create the ClearQuest databases that your users will use with ClearQuest. You
will create the master database or schema repository with the ClearQuest
Maintenance Tool first, and then create the user database(s) with the
ClearQuest Designer.

b Set up the configuration management integrations with Rational ClearCase or
Rational ClearCase LT. Within ClearCase, use the ClearQuest Integration
Configuration tool. Within ClearQuest, use the Package Wizard to apply the
ClearCase package to a schema. See the ClearQuest administrator’s manual for
more information.

� To use the ClearQuest/ClearCase UCM integration, consult the Managing
Software Projects with ClearCase and the ClearQuest administrator’s manual.

� To set up the integration with Microsoft Visual SourceSafe, use the Package
Wizard to apply the Visual SourceSafe integration package to a schema.

c Configure the Rational E-mail Reader application to allow users to submit and
modify records through e-mail messages. Setting up Rational E-mail Reader is
different from enabling e-mail notification in ClearQuest Web. The E-mail
Reader is an e-mail processing tool that is automatically installed in the
\Rational\common\ directory. To set up the E-mail Reader, see the mailreader.hlp in
the same directory. For more information about the E-mail Reader, see the
ClearQuest administrator’s manual.

2 See the ClearQuest administrator’s manual for details on customizing ClearQuest.

3 On each client system, instruct users to perform the following tasks:

a Connect to the schema repository.

b Enter the database properties information or load the user profile file
(cqprofile.ini) that you have created for them.

c Enable e-mail notification through the ClearQuest main menu.
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Configuring the Rational ProjectConsole Agent (Optional)

The ProjectConsole server can also act as an agent for collecting artifacts from
Rational development tools and Microsoft Project. Setting up additional systems as
agents is optional.

To set up and run an agent:

1 Use a Custom installation type to install the ProjectConsole agent software. If you
plan to use an agent to collect data from several Rational products, we recommend
that you install Rational Suite Enterprise on the agent so that it can collect data
from all of the supported Rational tools.

2 Configure the agent software.

3 Start ProjectConsole on the ProjectConsole agent.

4 Log in to ProjectConsole from a client machine.

For information about how to complete these tasks, see Chapter 3, Installing Rational
ProjectConsole in the Rational ProjectConsole Installation Guide.

Configuring the Rational RequisitePro Server

After installing RequisitePro, you can perform the following configuration tasks:

� To use an enterprise database (Oracle or Microsoft SQL Server) to contain your
RequisitePro project data, configure your database schema using the scripts and
instructions that are included with the Custom installation option. For
instructions, see “Configuring Enterprise Databases” in the Rational RequisitePro
Installation Guide.

� To use RequisitePro discussions for managing communication between your
project team members, configure e-mail discussions that are integrated with your
RequisitePro project. For detailed instructions, see “Configuring E-mail for
Discussions” in the Rational RequisitePro Installation Guide.
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7Configuring Web Servers
– Administrator
Rational Suite Web server components give users who do not have Rational Suite on
their systems the opportunity to access project data. The following Rational Suite
products offer Web components: ClearCase LT, ClearQuest, Manual Test Web,
ProjectConsole, and RequisitePro. See Table 8 on page 51 for the Web server system
and software requirements.

Configuring the ClearCase Web Interface

To run the ClearCase Web interface, configure third-party Web server software on the
ClearCase LT server. ClearCase LT Web components are included in the ClearCase LT
server installation. Because the ClearCase LT Web server components are part of the
ClearCase LT server installation, perform the Web server configuration after you have
installed and configured the ClearCase LT server.

See “Configuring a Web Server for the ClearCase Web Interface” in the Rational
ClearCase LT Administrator’s Guide for detailed procedures. You will find detailed
configuration tasks for Apache, Microsoft Internet Information Server (IIS), and
Netscape Enterprise Server.

The following list provides an overview of these instructions.

� If you use a Windows NT Web server, the server must run as a service and it must
be configured to log on as the System account. This is the default for Microsoft and
Netscape Web servers.

� To provide a secure port through which to access ClearCase, the ClearCase Web
interface can run through a secure port using Secure Socket Layer (SSL).

� For each third-party Web server you need to know the ccase-home-dir and
ccbase-url.

The ccase-home-dir is the location of the ClearCase installation directory, by default:

C:\Program Files\Rational\ClearCase on Windows NT

/usr/atria on UNIX
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The ccbase-url is the base URL for the interface. It can be any arbitrary string, for
example, ccaseweb or ccweb. The full path for the Web interface is:

http://server-name/ccbase-url/bin/ccweb.exe on Windows NT

http://server-name/ccbase-url/bin/ccweb on UNIX

If the server is on a secure port, the full ClearCase URL begins with https rather
than http.

� Provide client users with the full path for the Web interface after you have
configured the ClearCase LT Web server.

Configuring the ClearQuest Web Server

ClearQuest Web requires installing ClearQuest Web server components and setting
up the ClearQuest Web server. You can install the ClearQuest Web server and the
RequisiteWeb Requirements server on the same system.

Use the following overview to install and configure the ClearQuest Web components
on the Web Server. See Rational ClearQuest Installation Guide for detailed instructions.

Note: For improved performance, security, and reliability, we recommend that you
place the database server and the Web server on two different systems, each with its
software installed onto an NTFS partition.

1 Install the ClearQuest Web components on the Web server.

a Select a Rational Suite edition or Rational ClearQuest under Choose Product in
the Rational Software Setup program.

b Select the Custom Installation Type in the Select Configuration.

c In the Choose Features dialog box, select ClearQuest Web.

d If you do not want Rational Suite or the ClearQuest application installed on the
Web server, clear the check boxes for ClearQuest and other Rational Suite point
products.

2 Create an anonymous user account for IIS to use when it serves the ClearQuest
pages.

If you are using a SQL Server database, the anonymous user account should be
known in the domain that contains the ClearQuest database and should have full
access to that database.
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a Set up the access key registry privileges.

b Set up the read access permission to the directory tree containing the
ClearQuest Web files (WWW directory in the ClearQuest installation area).

3 Create and edit a cache directory in the ClearQuest Web directory hierarchy.

4 Create and edit a virtual directory for the Web.

5 Edit the properties of the images subdirectory.

6 Restart the Web server.

7 Enable e-mail notification support for Web clients on the Web server.

8 Set up registry key access privileges on the Web server.

9 Give users on Web clients the URL for ClearQuest Web.

Configuring ManualTest Web Execution

The Rational ManualTest Web Execution component of TestManager requires you to
install and configure ManualTest Web Execution software on a Web server and
configure a Web browser on each client to access a Rational project.

The Manual Test Web Execution lets you run a test case with a manual test script
implementation from a Web browser. To create a manual test script and associate it
with a test case, see the Rational TestManager User’s Guide.

Use the following overview to help you install and configure the Manual Test Web
Execution components on the Web Server. For detailed instructions and
troubleshooting, see the Rational Testing Products Installation Guide.

1 Create a shared project. We recommend that when you create a project, you make
it a shared project so others can access your manual test scripts from a Web
browser. To share a project, create the project in a shared directory and use the
Uniform Naming Convention (UNC) for the directory name. (For more
information about creating a shared directory, see the Rational Suite Administrator’s
Guide or the Rational Administrator Help.)

2 To install the ManualTest Web Execution components on the Web server:

After you select a Rational Suite edition that includes a testing product under
Choose Product in the Rational Software Setup program, do one of the following in
the Select Configuration dialog box:
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a If you do not want to create manual test scripts on the Web server and only
want to set up a Web server:

i Select the Custom Installation Type.

ii Clear all check boxes in Choose Features.

iii Select the Web Server Components check box.

iv Select the Rational ManualTest Web Execution check box.

b If you want to create manual test scripts on the Web server, select Typical to
install the Rational Suite edition.

Note: You do not need to install a Rational Suite on the Web server unless you
want to create manual test scripts on the Web server. The Manual Test Web
Execution component installs by default when you install any of the Rational
Suite editions that include Rational testing products.

3 Depending on the operating system, install the Microsoft Personal Web Server
(PWS) or the Microsoft Internet Information Server (IIS) from the Windows NT 4.0
Option Pack, or install Microsoft Internet Information Services 5.0 from the
Microsoft Windows CD-ROM on the Web server.

4 Install Microsoft Internet Explorer 5.0 or later on the Web server.

Note: Although clients use Microsoft Internet Explorer 4.0, you must install
Microsoft Internet Explorer 5.0 or later on the Web server.

5 Configure the Microsoft Access Driver.

6 Configure the Web server. See one of the following sections in the Rational Testing
Products Installation Guide.

❑ For a Web server running Windows XP Professional, Windows 2000
Professional, Windows 98, or a Windows NT 4.0 Workstation, see Configuring a
Microsoft Personal Web Server.

❑ For a Web server running Windows NT 4.0 Server, Windows XP Server,
Windows XP Advanced Server, Windows 2000 Server, or Windows 2000
Advanced Server, see the next section, Configuring a Microsoft Internet
Information Server.

7 Configure the Web browser. See Setting Up a Web Browser in the Rational Testing
Products Installation Guide.
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Configuring the ProjectConsole Server

The ProjectConsole server is a Web server that serves project data to client browsers.

To configure the ProjectConsole server software:

1 Create a ProjectConsole virtual directory in IIS.

2 Create a Jakarta virtual directory.

3 Create an ISAPI filter.

4 Add index.html to the default documents list.

5 Restart IIS.

You do not need to configure agent software on the ProjectConsole server. If you have
installed agent software on additional systems, configure the agent software on those
systems.

Before you create the metrics warehouse, install and configure the schema repository
and warehouse databases.

For information about how to complete these tasks, see Chapter 3, Installing Rational
ProjectConsole in the Rational ProjectConsole Installation Guide.

Configuring the RequisiteWeb Server

RequisiteWeb requires installing Web server components and setting up a Web server
configuration. You can install the ClearQuest Web server and the RequisiteWeb
Requirements server on the same system.

To set up RequisiteWeb, choose from the following possible Web server
configurations:

� If you use Microsoft Internet Information Server (IIS) on Windows NT 4.0 or
Windows 2000 on your Web server, configure a single Windows server for your
RequisiteWeb Requirements server.

� If you use Linux or Sun Microsystems Solaris for an operating system on your Web
server, configure both your UNIX Web server and another Windows server for
managing the RequisiteWeb artifacts.

An overview of these components, configurations, and set-up instructions are also
provided in the RequisiteWeb Installation and Configuration document from the online
Release Notes in RequisitePro.
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Use the following overview to install the RequisitePro Web components on the
RequisiteWeb Requirements server:

1 Select a Rational Suite edition or RequisitePro under Choose Product in the
Rational Software Setup program.

2 Select the Custom Installation Type in Select Configuration.

3 In the Choose Features dialog box, select RequisiteWeb under Web Server
Components.

4 Select or clear the following optional check boxes:

❑ The RequisiteWeb Sample Projects are helpful for testing and learning
RequisiteWeb.

❑ If you do not want other Rational Suite point products installed on the Web
server, clear the check boxes for these products.
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8Upgrading from Earlier
Versions of Rational Suite
If you upgrade to Rational Suite 2002 from an earlier version, you need to upgrade
your software and datastores in a specific order to continue using data created in
earlier versions. When you upgrade, you need to upgrade all computers in your
environment so that datastores and software are all running the same version of
Rational software. Read this chapter to understand how to upgrade successfully.

The information in this chapter collects information available in documentation for
individual products. Any changes made after this book went to press are recorded in
the Rational Suite Release Notes.

Table 12 describes how to proceed, based on the version of Rational Suite that is
currently installed on your network.

Table 12 Upgrading Rational Suite

If you are starting from this version Then upgrade as follows

Rational Suite 2001A or 2001 Follow the procedures in this chapter.

Rational Suite 2000 1 Upgrade to version 2001A, as described in
“Upgrading from Earlier Versions of Rational
Suite” in the 2001A version of Installing Rational
Suite (see www.rational.com/documentation).

2 Upgrade from version 2001A to the current version
by following the procedures in this chapter.

Rational Suite 1.5, 1.1, or 1.0 1 Upgrade to version 2000, following the procedure
supplied by Rational Technical Support.

2 Upgrade from version 2000 to version 2001A, as
described in “Upgrading from Earlier Versions of
Rational Suite” in the 2001A version of Installing
Rational Suite (see
www.rational.com/documentation).

3 Upgrade from version 2001A to the current version
by following the procedures in this chapter.

A Rational point product, any version Contact Technical Support for more information.
79



Overview of Upgrading

This chapter describes how to perform the following tasks:

� Instruct users to disconnect from Rational products, or, from the server, disconnect
active users.

� Prepare to upgrade.

� Install new software on servers and clients.

� Upgrade installed products, including their datastores.

Note: If you experience problems while working with this chapter, contact Rational
Technical Support.

Preparing to Upgrade

To prepare to upgrade to the current version of Rational Suite, perform these tasks:

� Plan your upgrade.

Design the upgrade process so that you upgrade software and datastores, and then
test. If you are planning major changes to your environment, perform them after
determining that the upgrade is successful. Do not attempt to make major changes
to your Rational Suite environment in the middle of the upgrade. An example of a
major change is switching a vendor database or enabling a project for use with
Unified Change Management.

� Back up your databases and datastores.

We strongly recommend that you back up your databases and datastores on a
regular basis. Before upgrading, make sure that you have backups of all your data,
and back up different datastores at the same point in the project (this is sometimes
called a “simultaneous” backup). Doing so will ensure project consistency should
you need to restore your data.

For more information about backing up, contact Rational Technical Support.

� Read the Rational Suite Release Notes to learn of any updates to these upgrade
procedures.

The Release Notes are in the top-level directory of the Rational Solutions for
Windows installation CD-ROMs, in the readme.htm file.
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� Ensure that all clients are disconnected from the Rational software you will
upgrade. This means that users should have no connections to a Rational project or
its datastores, and should not use any Rational tools involved in the upgrade until
further notice.

Planning to Upgrade ClearCase or ClearCase LT

If you use Rational ClearCase or Rational ClearCase LT to store Rational data, make
these preparations:

� Under some circumstances, your team may not be able to upgrade all its clients
and servers to the newest version of ClearCase. To assess the possibility of
working in a mixed-version ClearCase environment, contact Rational Technical
Support before proceeding with the rest of this upgrade.

� If you use ClearCase or ClearCase LT with Rational RequisitePro or Rational Test,
make sure that those assets are available through a ClearCase view.

� If you established the integration between Rational Suite and ClearCase by using
the Rational Administrator to create a UCM-enabled project, your RequisitePro
and Rational Test assets are already checked out and you don’t need to take
further steps. We recommend, however, that you perform the following steps so
that you can revert to the current version should the need arise:

❑ Use the Rational Administrator to perform a Check in All operation for the
RequisitePro project and the Test datastore. (In the Administrator, on the
Configure dialog box for your project, click Check in All for both datastores.
ClearCase checks in all project-related assets, then checks them out again.)

❑ Create a baseline (In the ClearCase Project Explorer, select the project, then
click Tools > Make Baseline).

� If you used another method to integrate Rational Suite and ClearCase, then:

❑ We recommend that you create a label to mark the latest versions of your
datastores. This will allow you to revert to the current version should the need
arise.

❑ Check out RequisitePro and Rational Test assets that you store in ClearCase. If
you do not, the upgrade will fail.
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Planning to Upgrade ClearQuest and ClearQuest MultiSite

If you use Rational ClearQuest and want to author report formats, upgrade to Crystal
Reports 8.0.

If you are upgrading from a ClearQuest MultiSite environment, then plan the
upgrade as follows:

1 If you have set up automated tasks that synchronize replicas, disable them at all
sites during the upgrade.

2 Follow the instructions in this chapter to upgrade the software and data at the site
that has mastership of your schemas (this site is called the working master site).

3 Install new software at the replica sites.

4 Synchronize to replicas: export updates from the master to the replicas, then at
each replica site, import the updates.

During the import at each site, a warning message appears saying that ClearQuest
could not replay all transactions because of the mismatch of schema versions. It is
safe to ignore this message.

5 At the replica sites, upgrade datastores as described in this chapter. When
upgrading ClearQuest:

❑ Skip the steps about “Upgrading ClearQuest Packages” on page 89 (this step
happens in the synchronization).

❑ Resume with “Applying Schema Changes to User Databases” on page 99.

6 Synchronize to replicas again, this time importing only. No warning messages
(such as the ones you saw in 4) should appear.

7 Re-enable any tasks that synchronize replicas automatically.

Installing New Software

This section describes how to use the Rational Software Setup program to install the
new version of Rational Suite. It also outlines tasks that you need to perform both
before and after you install.
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Before You Install

Before you install Rational Suite, perform the following tasks:

1 Under certain circumstances, described later, remove earlier versions of Rational
Suite from your computer.

2 Make sure that the computers on which you’re installing software meet
prerequisites. These prerequisites may have changed since the last time you
installed Rational software. (See Before You Install – Client on page 21 and Before You
Install – Administrator on page 45 for more information.)

3 Determine which Rational Suite point products you’re adding to your
environment, and perform pre-installation tasks for them.

The remainder of this section describes these tasks in more detail.

Removing Earlier Versions of Rational Suite

Before you can proceed with the upgrade, remove earlier versions of Rational Suite if
any version of the following software is installed on your computer:

� Beta releases of Rational products
� Rational Suite DevelopmentStudio RealTime Edition
� Rational Rose RealTime
� Rational RequisiteWeb (which is installed on a RequisiteWeb server only;

RequisiteWeb is not installed on client machines)
� Rational Process Workbench

To remove Rational software:

1 Read about special procedures for removing software in Removing Rational Suite –
Administrator on page 129. If you are removing RequisiteWeb, see the Rational
RequisitePro Installation Guide, and read about “Uninstalling RequisiteWeb” in the
chapters about “Installing and Configuring Rational RequisiteWeb” for Windows
or for UNIX.

2 Use the Windows Add/Remove Programs option in the Control Panel to select and
remove Rational Suite or Rational Suite products. Windows starts the Rational
Software Setup program which removes the software from your system.
Installing New Software 83



Performing Tasks Before You Install New Point Products

As part of upgrading to a new version of Rational Suite, it is likely that you will be
adding new point products to your environment. You might add new point products
for some of these reasons:

� The point product is part of Rational Suite in the current version, but it wasn’t part
of Rational Suite when you installed the version you are now using.

� You are adding new editions of Rational Suite to your environment, thereby
introducing new point products.

� You have been adopting Rational Suite incrementally, and you are now adding
new point products to your environment.

� Before upgrading, you removed a point product that you will re-install during the
upgrade.

To prepare for installing new point products:

1 Compare the point products now installed in your environment (click Start, then
click Programs > Rational Suite and scan the menu) to the table on page xiv that
shows point products in each Rational Suite edition.

2 Determine which new point products you will install as part of this upgrade.

3 For each new point product, follow the instructions in Before You Install –
Administrator on page 45.

4 Install Rational Suite Version 2002.

5 After installing, perform the post-installation steps for those same point products,
as described in Configuring Rational Servers – Administrator on page 69. After you
install, we remind you to perform this set of tasks.

Use Table 13 as a worksheet to track your progress.
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Table 13 Upgrade Worksheet

Suite Point Product New?
Completed
Pre-Install
Tasks?

Completed
Post-Install
Tasks?

Comments or Notes

Rational ClearCase LT

Rational ClearQuest

Rational ClearQuest Web

Rational PureCoverage

Rational Purify

Rational Quantify

Rational Process Workbench

Rational ProjectConsole

Rational RequisitePro

Rational RequisiteWeb

Rational Rose

Rational Rose RealTime

Rational SoDA for Word

Rational Testing products

Rational Unified Process
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Installing the Latest Version of Rational Suite

Use the Rational Software Setup program to install Rational Suite on all servers and
clients, as described in the chapters Installing Rational Suite – Administrator on page 61
and Installing Rational Suite – Client on page 33.

Perform the installations in the following order:

1 If you are working with ClearCase LT or ClearCase:

❑ For ClearCase LT, install software on the ClearCase LT server.

❑ For ClearCase, upgrade to ClearCase Version 5.0 on these systems in this order:

� License servers

� Registry servers

� VOB servers

� View servers

2 Upgrade software on all other servers, including Web servers.

3 Upgrade software on all client computers.

Performing Tasks After You Install New Point Products

Earlier in this chapter, you filled in a worksheet (Table 13 on page 85) listing the new
point products you are adding to your Rational Suite environment. For those new
point products, perform post-installation steps, as described in Installing Rational Suite
– Administrator on page 61.

Upgrading Installed Point Products: Overview

At this point, you have installed new software on your servers and clients. The
remainder of this chapter describes how to:

� Upgrade ClearCase
� Upgrade ClearQuest
� Upgrade a Rational Project (which upgrades RequisitePro and Rational Test

datastores)
� Upgrade Rational Process Workbench
� Perform last tasks to finish the upgrade process
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Upgrading ClearCase

This section describes how to upgrade ClearCase by performing the following tasks:

� Raising the feature level of your VOBs
� Reformatting some ClearCase views

Incrementing VOB Feature Level

With nearly every new release, ClearCase increments an internal feature level number.
Each new feature level indicates support for a set of features introduced in the release.
To take advantage of the new features, you need to change the feature level in each
ClearCase VOB.

Raising the feature level allows a VOB created in an earlier release to use features
introduced in a later release. In a MultiSite environment, raising a feature level also
advertises to the MultiSite family the functions that a VOB can perform.

In this release, the new feature level supports the following UCM features:

� Creation of baseline dependencies (composite baselines)
� Creation of components without root directories
� Using composite baselines to configure a stream
� Creation of sub-VOB components
� Creation of nested streams
� Setting of new project and stream policies

The following table describes the effect of raising or not raising the feature level:

If you Then

Raise the feature level of all
your VOBs

� You can take advantage of the new UCM features.
� ClearCase clients using the previous version (ClearCase LT

2001A or ClearCase 4.2) have read-access but not
write-access to your VOBs.

Do not raise the feature level
of any VOBs

� You cannot take advantage of the new UCM features.
� ClearCase clients using the previous version have both

read- and write-access to your VOBs.
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To change the feature level, in a command window, use the cleartool chflevel

command as follows:

cleartool chflevel –force –auto

For more information about chflevel, see the ClearCase LT Reference or the ClearCase
Reference.

Reformatting ClearCase Views

ClearCase view data is stored in a view database. The current version of ClearCase,
Version 5.0, uses a new view database format, requiring each view to be reformatted.
You can choose to reformat in one of the following ways:

� Automatically. ClearCase automatically reformats a view the first time it is used
with the current release.

� Manually. You may choose to reformat some views manually using the cleartool
reformatview command. We recommend that you manually reformat a view if it
has a large database. By reformatting manually, you minimize the chance that
clients will experience view access timeouts during automatic view reformats.

Note: After a view has been reformatted to the ClearCase 5.0 format, it cannot be
reformatted to the earlier format.

Upgrading ClearQuest

This section describes how to upgrade ClearQuest schemas and databases created
with a previous version of ClearQuest.

This section is written for ClearQuest administrators or people who are comfortable
with administrative concepts related to ClearQuest. Before you start upgrading
ClearQuest, you may want to have the Rational ClearQuest Administrator’s Guide and
Rational ClearQuest Installation Guide available.

Understanding the Upgrade Process for ClearQuest

To upgrade ClearQuest, you perform these general tasks:

1 Start ClearQuest, as described in Starting ClearQuest on page 89.

2 Start the ClearQuest Designer and log on using Super User or Designer privileges.

3 Upgrade ClearQuest packages, test your databases, and check in the changes to
the schema repository. See Upgrading ClearQuest Packages on page 89.
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4 Apply schema changes to your user databases. See Applying Schema Changes to
User Databases on page 99.

We recommend you perform Step 3 and Step 4 during the same logon session.

5 Optionally, upgrade ClearQuest feature levels if you want to enable new
ClearQuest features. See Upgrading ClearQuest Feature Levels on page 100.

6 Inform end users that they can now resume work. (We remind you to do this after
you finish other upgrade tasks in this chapter.)

Starting ClearQuest

After you install a new version of ClearQuest and start ClearQuest for the first time,
ClearQuest connects you to the schema repository you were most recently connected
to. ClearQuest names this connection 2002.05.00.

Upgrading ClearQuest Packages

Each ClearQuest package implements a ClearQuest integration (for example, with
Rational RequisitePro) or a feature, for example, e-mail rules. If you use ClearQuest in
a Rational Suite environment, it is likely that you use at least one of these packages.
Carefully follow the instructions in this section to upgrade the associated ClearQuest
packages.

To upgrade ClearQuest packages, you perform these high-level steps, as detailed in
the remainder of this section:

1 For each schema, apply package upgrades.

2 In some cases, perform additional steps.

3 Test your changes, then check in the changes to the schema repository.

4 Apply schema changes to your user databases. See Applying Schema Changes to
User Databases on page 99.

Note: This chapter provides procedures for upgrading packages, but it does not
provide information about the features that each package implements or about the
dependencies among packages. For more detailed information about ClearQuest
packages, see the appendixes in the Rational ClearQuest Administrator’s Guide.
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Applying Package Upgrades

To upgrade ClearQuest packages:

1 Start the ClearQuest Designer if it is not already open:

a Click Start, then click Programs > Rational Suite > Rational ClearQuest > Rational
ClearQuest Designer.

b Log on with Super User or Designer privileges.

c If the Open Schema Wizard appears, click Cancel to dismiss it. (You can control
whether the wizard appears by clearing or setting the Show this wizard at
startup option.)

2 Take the appropriate step described in the following table.

3 From the Designer menu, click Package > Upgrade Installed Packages to display
the Upgrade Installed Packages wizard.

4 On the Select a schema to upgrade page, the wizard lists the available schemas. Select
the schema you want to upgrade.

The Upgrade Installed Packages wizard checks out the schema, analyzes which
packages need upgrading, and determines whether there are any prerequisites to
those packages.

5 On the Status page, note the list of packages that need upgrading.

Note: You may want to select and copy this list into a text file for later reference;
some packages require additional work, as described later in this section.

If you are upgrading from Proceed as follows

Version 2001A Go directly to Step 3.

Version 2001 In many cases, the AMStateTypes package will be added
because it is a new prerequisite for an existing package,
UnifiedChangeManagement. Perform the steps in Before
Applying the AMStateTypes Package on page 92, then
continue with Step 3.
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The wizard applies packages to the schema in the correct order and displays the
status:

When the wizard finishes, read the status message to verify that the package
upgrade was successful. In the open schema, inspect the changes and possibly
perform additional tasks. Complete the work for this schema before upgrading
other schemas.

6 Validate the changes you’ve made: from the Designer menu, click File > Test Work.

7 If you are applying certain packages, perform these additional steps:

8 Check in the schema: from the Designer menu, click File > Check In.

9 Repeat this procedure from Step 3 for additional schemas that need upgrading.

If you are applying package Perform these steps

RequisitePro or
RequisitePro Upgrade

Perform the steps in After Applying the RequisitePro
Package on page 94.

Email After applying schema changes to the user databases (on
page 99), verify that the e-mail notification for each of
your end users is enabled. For each type of end user
(Windows, UNIX, and Web), see the appropriate section
in Rational ClearQuest Installation Guide (the section titles
all start with “Enabling e-mail notification for...”)

We remind you to perform this task after you apply the
schema change.
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Before Applying the AMStateTypes Package

The AMStateTypes package is a new package that is a prerequisite for the
UnifiedChangeManagement package. If the UnifiedChangeManagement package is
not included in your schema, then you do not have to perform the steps in this
section.

Determining Whether to Perform the Steps in this Section

To determine whether you need to follow the steps in this section:

1 In the ClearQuest Designer, click View > Schema Summary

2 Expand the folder containing the schema you are working with and select the
current version.

3 In the Associated Package list, determine whether UnifiedChangeManagement is
listed:

❑ If it is listed, then perform the steps in this section.

❑ If it is not listed, continue with Step 3 on page 90.

Mapping AMStateTypes States

To prepare for the AMStateTypes package, you apply the package, then map certain
states:

1 In the ClearQuest Designer, click Package > Package Wizard.

2 Select AMStateTypes either from the displayed list or from the list displayed
after you click More Packages.

3 Select the schema you are working with.
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4 On the Setup State Types page, associate the AM State Types with the states
defined in your schema. For each defined state (listed in the States column), select
the corresponding AM State Type from the State Type column.

For record type BASECMActivity, we recommend the following associations:

For record type Defect we recommend the following associations:

5 Click Finish.

6 From the Designer menu, click File > Check In.

7 Continue with Step 3 on page 90.

State State Type

Submitted

Ready

Active

Complete

Waiting

Ready

Active

Complete

State State Type

Submitted

Assigned

Opened

Resolved

Closed

Duplicate

Postponed

Waiting

Ready

Active

Complete

Complete

Complete

Waiting
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After Applying the RequisitePro Package

Proceed according to the following table.

Overview

To enable the integration of ClearQuest and RequisitePro, you need to create an
association between ClearQuest record types and RequisitePro requirement types.
You create this mapping by editing and running a batch file. You need to perform this
work even if you performed it for an earlier version.

The following sections describe the required steps:

� Collecting data related to your ClearQuest database and RequisitePro project
environment.

� Editing the ASCQISetup.bat batch file.

� Deleting existing RequirementMap records in ClearQuest.

� Later in this chapter, we instruct you to run the edited ASCQISetup.bat batch file.

If Then

You are upgrading from Rational Suite 2001A,
and you configured the RequisitePro package
for that earlier version

You can safely skip the steps in this section
and continue with Step 7 on page 91.

You are upgrading from Rational Suite 2001
and you configured the RequisitePro package
for that version

Perform the steps in this section after
applying the RequisitePro package. At a high
level, this section tells you how to establish
associations between ClearQuest and
RequisitePro to enable the integration
between the two products. To establish these
associations, you edit a utility,
ASCQISetup.bat.

Later, you run the ASCQISetup.bat utility.
(We remind you at the appropriate time.)

You have not set up the integration between
RequisitePro and ClearQuest and you wish to
do so now.

Complete the tasks outlined in this chapter
and ensure that the upgrade is successful.
Then read about “Configuring the Integration
for ClearQuest and RequisitePro” in the
Rational Suite Administrator’s Guide.
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Collecting Setup Information

To enable the integration in your specific environment, edit the ASCQISetup.bat batch
file. This file contains the command arguments shown in Table 14. Use this table to
record the values of each variable for your project. You will use this information to
edit the batch file. (Hint: Because you created an ASCQISetup.bat file for an earlier
release, you can gather most, if not all, of this information from the original file.)

Note: If your installation spans multiple computers, use Universal Naming
Conventions (UNC) paths, as noted in Table 14.

Table 14 Variables Describing Your Environment

Batch Command Description Must Edit Your Values

set CQDatabaseName
=

The internal name of
the ClearQuest User
database (for
example, SAMPL),
available from the
ClearQuest Designer
menu View >
Database
Summary.

You must edit this
entry.

set H = The hard drive letter
where RequisitePro
is installed, followed
by a colon (for
example C:). This
refers to the
Administrator’s
installation, not the
client installation.

The default value is
C. Edit this entry
only if you installed
RequisitePro on a
drive other than the
C drive.

set U = The logon name for
the ClearQuest
database, the
RequisitePro project,
and the Rational
Project. This logon
name has Super User
privileges.

By default, the logon
name admin has
Super User
privileges for
ClearQuest. If you
are using a logon
name other than
admin for
RequisitePro,
ClearQuest, or the
Rational Project, edit
this field.

set P = The path to the
administrator’s local
Rational installation
directory.

You must edit this
field.
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Editing the ASCQISetup.bat File

Now use the information in the preceding table to modify the ASCQISetup.bat file for
your specific environment. The file is in the directory
Install\Program Files\Rational\Common. The ASCQISetup.bat file is designed to be run only
by the administrator and all settings in this file should reflect those of the
administrator’s installation. After the file runs, it does not need to run again unless
one of the above variables changes. Edit and run this file once for each RequisitePro
and ClearQuest project that you want to integrate.

Begin by saving a copy of the ASCQISetup.bat file with a name that corresponds to
your Rational project (you use the Rational Administrator to create a Rational project).
For example, you might create a copy named ASCQI_RA_project_name.bat. Edit this
copy to include the data specific to your ClearQuest database and RequisitePro
project environment as follows:

set RP = The name of the
RequisitePro project
as displayed in the
RequisitePro Project
> Open dialog box.

You must edit this
field.

set RQS = The full directory
path to the
RequisitePro *.rqs
file

You must edit this
field. If your
installation spans
multiple computers,
use a UNC path.

set Help= The full path to the
ClearQuest/
RequisitePro
Integration help file
(Program Files\

Rational\
RequisitePro\
Help\CQI.hlp).

You must edit this
field if the CQI.hlp
file is in a location
other than the
default location
listed in the
ASCQISetup.bat file.
If your installation
spans multiple
computers, use a
UNC path.

Table 14 Variables Describing Your Environment (continued)

Batch Command Description Must Edit Your Values
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1 Use a text editor such as Notepad to open the file.

2 At each set command, replace the variable, including the angle brackets (<< >>),
with the value you supplied in Table 14.

Note: Use double quotes (“ “) to enclose information containing spaces.

Example

The following example of a modified ASCQISetup.bat file was edited to work with the
integration for the Rational Suite Tutorial data, which is used throughout the
document, Getting Started: Rational Suite AnalystStudio. This sample batch file reflects a
local installation of RequisitePro and an unmodified help file. Remember to use UNC
paths when necessary to reflect your installation environment.

Note: Edited fields are in bold. (The angle brackets from the original file should not
appear in the final file.) The REM command precedes a comment.

REM Before you launch this batch file, please update the following
information:

REM **** INFORMATION TO UPDATE ****

REM Update the name of the ClearQuest database.
set CQDatabaseName=CLSIC

REM Update the hard drive letter where your local Rational products are
installed.
set H=C:

REM Update the Super User logon name for ClearQuest database and
RequisitePro project.
set U=admin

REM Update the path to your local Rational installation directory.
set P=\\Server_Name\Program Files\Rational\

REM Update the name of your RequisitePro project.
set RP=”Order Processing and Fulfillment System”

REM Update the full name to your RequisitePro.rqs file.
REM Use a UNC path for a project on a nonlocal computer.
set RQS=”\\Server_Name\Program Files\Rational\Classics Demo\
ClassicsRepo\Project\ClassicsPOS\Requisite\requisite.rqs”
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REM Update the path to the cqi.hlp file.
REM Use a UNC path for a project on a nonlocal computer.
set Help=”\\Server_Name\Program Files\Rational\RequisitePro
\help\cqi.hlp”

REM **** BEGINNING OF THE SCRIPT ****

%H%
cd %P%\common

REM Create the association between the 'Defect' ClearQuest record type
and the RequisitePro attribute 'Defect' of the Feature requirement
type.

ASCQISetup.exe -c %U% %CQDatabaseName% Defect Requirements_List
Defects_list RAProject Modify "Associate Defects" "%Help%" 1 "%RP%"
"%RQS%" FEAT Defect 2

pause

REM Create the association between the 'EnhancementRequest' ClearQuest
record type and the attribute 'EnhancementRequest' of the Feature
requirement type.

ASCQISetup.exe -c %U% %CQDatabaseName% EnhancementRequest
Requirements_List EnhancementRequests_list RAProject Modify "Associate
Enhancement Requests" "%Help%" 1 "%RP%" "%RQS%" FEAT
EnhancementRequest 2

pause

Notes:

� For more information about customizing the integration or about the
ASCQISetup.exe command arguments, see the chapter about “Configuring the
Integration for ClearQuest and RequisitePro” in the manual, Rational Suite
Administrator’s Guide.

� If you are working with a RequisitePro project that does not have security enabled,
set your RequisitePro default project logon user name to the Super User logon
name specified in the ASCQISetup.bat file. This setting is available through the
RequisitePro Tools > Options menu command.
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Deleting Existing RequirementMap Records

When you eventually run the batch file, the file will create RequirementMap records
in ClearQuest. Your ClearQuest database already contains RequirementMap records,
which were created when you originally set up this integration. Delete those existing
records now:

1 Start ClearQuest and log in.

2 Create a new query that searches on the record type RequirementMap.

3 Use the Query Wizard to specify at least one field to display, for example,
RPProjectName. (You do not need to specify filtering criteria.) Run the query.

4 For each record found, click Actions > Delete to remove the record from the
ClearQuest database.

Applying Schema Changes to User Databases

This section describes how to apply schema changes to your user databases. Perform
these steps now. In general, you should always perform the steps in this section after
making changes in the ClearQuest Designer, such as applying packages. The effect of
performing these steps is to push changes in your schema to the user databases.

Applying schema changes takes just a few minutes for each user database.

Warning: After you apply schema changes, you cannot reverse or undo the action.
Always back up your databases before starting this procedure.

To apply schema changes:

1 Start the ClearQuest Designer: click Start, then click Programs > Rational Suite >
Rational ClearQuest > Rational ClearQuest Designer. Log on with Super User or
Designer privileges.

2 If the Open Schema Wizard appears, click Cancel.

3 From the Designer menu, select Database > Upgrade Database.
A message warns you that this action cannot be reversed, recommends that you
back up your databases before proceeding, and asks you if you want to continue. If
you have backed up your databases, click Yes.

4 Select the user database from the list in the Upgrade Database Wizard. Click Next.
Upgrading ClearQuest 99



5 On the next page, from the list, select the version of the schema (typically the
latest) to which you wish to upgrade the user database.

If your most recent version does not appear in this list, it probably is not checked
in. In that case, click Cancel to quit this wizard. On the Designer menu, click File >
Open Schema, then check in the schema. You can now restart this process.

6 Click Finish. When the upgrade completes, a message appears saying that the
database has been upgraded successfully.

After Applying Schema Changes

After applying schema changes, perform these steps:

1 Reminder: If you applied the Email package, verify that e-mail notification is
enabled for each end user. See Step 7 on page 91.

2 Update your maintenance plans to include new user databases and schema
repositories, and to omit the old ones.

You have now applied schema changes to your ClearQuest user database.

Upgrading ClearQuest Feature Levels

This section describes how to upgrade ClearQuest feature levels. These steps are
optional, as follows:

� Perform these steps if you want to enable new features in the current version of
ClearQuest. In Version 2002, these new features are Rational ClearQuest MultiSite
(introduced in 2001A.04.20) and an improved security model (introduced in
Version 2001A).

� Do not perform these steps if you do not want to enable these new features. Also, if
you are upgrading from Version 2001A and you upgraded the ClearQuest feature
level in that version, you do not have to perform the steps again.

Upgrading ClearQuest feature levels can take several hours. The upgrade changes the
schema repository and all its associated user databases. Typically, new tables are
added to all databases, and new columns may be added to existing tables.

Scheduling the Feature Level Upgrade

You can perform a feature level upgrade at any time, not just while you’re upgrading
a version of Rational Suite. You may want to perform the work now. Alternately, you
may want to finish the other tasks in the Suite upgrade now and allow users to
resume their work, then upgrade the ClearQuest feature level later. While both
options are possible, this chapter assumes you are upgrading the feature level now.
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Overview of Upgrade Process

As part of upgrading ClearQuest feature levels, we strongly recommend that you
perform the upgrade first on a test system, and then perform it again on production
databases. At a high-level, the process is as follows:

1 Verify your environment.

2 Create a test bed based on production databases.

3 Upgrade the test bed and validate that the upgrade was successful.

4 Create new databases for the production system.

5 Upgrade the production databases and validate that the upgrade was successful.

The following illustration shows the general process for creating the test bed,
upgrading it, and validating the upgrade. The process for upgrading production
databases is similar.
Upgrading ClearQuest 101



Verifying Your Environment

Before you start the upgrade, be aware that the upgrade could fail under certain
conditions. Table 15 describes these conditions and how to resolve them.

Creating a Test Bed

The following steps describe how to create a test bed based on your production
databases:

1 Make sure you have a backup copy of your ClearQuest schema repository and
user databases, as described in Preparing to Upgrade on page 80.

Upgrading ClearQuest feature levels changes the underlying structure of your
data and schemas. We strongly recommend you create a backup, if you haven’t
done so already, so you can revert to it if necessary.

2 Create new, empty vendor databases for each schema repository and user
database, as described in “Configuring Vendor Databases” in the Rational
ClearQuest Installation Guide. Create the new databases in a new test directory or on
a test server. In this section, we refer to these new databases as the test bed.

Note: Create empty databases only. Do not use your vendor database tools to
move or copy the data. ClearQuest updates the data structure and moves it into
the new databases as part of the upgrade process.

Table 15 Troubleshooting: Upgrading ClearQuest Feature Levels

Condition Solution

You currently have a ClearQuest schema
checked out.

Check in your ClearQuest schema.

Your ClearQuest database is locked. Unlock your database. For more information,
read “Unlocking Databases” in the chapter,
“Upgrading Rational ClearQuest” in Rational
ClearQuest Installation Guide.

You have customized your schema to include
Record Types or fields that have a ratl_ prefix.

Contact Rational Technical Support. They
will explain how to correct this condition.
102 Chapter 8 - Upgrading from Earlier Versions of Rational Suite



3 Shut down your web server, stop any scheduled ClearQuest MultiSite
synchronization jobs, and ensure that all users have disconnected from ClearQuest
by using one of these techniques:

❑ Some high-end databases give the administrator a tool for logging users off
from the database. Check your vendor database to see if it has such a tool.

❑ Check the Task Manager Process List of each client and server computer. If one
of these processes is running, use the Task Manager to end the process:

clearquest.exe, cqdesign.exe, or any cqintsvr*.exe process

4 Copy your existing production schema repository and user databases to the test
bed databases. Use the ClearQuest installutil utility with the options,
convertschemarepo and convertuserdb. For more information about this utility,
read about “Creating Database Copies” in the chapter, “Upgrading Rational
ClearQuest” in the Rational ClearQuest Installation Guide.

Using the convert options with the installutil utility causes ClearQuest to
lock the original production databases. If you need to unlock them, read about
“Unlocking Databases” in the chapter, “Upgrading Rational ClearQuest” in the
Rational ClearQuest Installation Guide.

5 For each database in the test bed, create another new empty vendor database.
These will be the databases that you upgrade to. In this section, we refer to these
new databases as the test upgrade set.

Upgrading the Test Bed

In this section, you upgrade the test bed and verify that the upgrade was successful.
Upgrade the test bed as follows:

1 Start the ClearQuest Maintenance Tool: click Start, then click Programs > Rational
Suite > Rational ClearQuest > Rational ClearQuest Maintenance Tool.

2 From the Existing Connections list, select the connection to the schema repository
that you want to upgrade. We recommend that you use the default connection,
2002.05.00.

3 From the ClearQuest Maintenance Tool menu, select Schema Repository > Upgrade
> Selected Connection.

4 At the prompt to upgrade user databases, click Yes to continue.

5 Log in with Super User privileges.

6 Enter the properties of the schema repository to upgrade to (the empty database
you created in the test upgrade set), then click Next.
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7 Enter the properties for the first user database you are upgrading to (the empty
databases you created in the test upgrade set). Click Next. Repeat until you have
associated all the user databases. Click Finish.

ClearQuest upgrades your schema repository and user databases, and notifies you
when the process is complete. It records all actions in a text file in the \Temp

directory.

8 Verify that the upgrade process completed successfully:

a When the upgrade process completes, carefully read the status message to
ensure that the process completed successfully (scroll until you reach the end of
the message). Click Done.

b Test the application. Enter a few test records of each record type and move
them though the entire state model to be sure the upgrade is working correctly.

Creating Production Databases

After you verify that the test upgrade is successful, proceed to upgrade your
production databases. The steps for upgrading production databases are nearly
identical to those for upgrading the test databases.

The following steps describe how to upgrade production databases:

1 Create empty vendor databases for each schema repository and user database, as
described in “Configuring Vendor Databases” in the Rational ClearQuest
Installation Guide. Create the new databases on the production server. In this
section, we refer to these new databases as the production upgrade set.

Note: Create empty databases only. Do not use your vendor database tools to
move or copy the data. ClearQuest updates the data structure and moves it into
the new databases as part of the upgrade process.

2 Notify users to log off from ClearQuest, if any are logged in, shut down your web
server, and stop any ClearQuest MultiSite synchronization jobs.
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Upgrading the Production Databases

In this section, you upgrade from your original production databases to the
production upgrade set. The process is similar to the process for upgrading the test
bed:

1 Start the ClearQuest Maintenance Tool: click Start, then click Programs > Rational
Suite > Rational ClearQuest > Rational ClearQuest Maintenance Tool.

2 From the Existing Connections list, select the connection to the schema repository
that you want to upgrade. We recommend that you use the default connection,
2002.05.00.

3 From the ClearQuest Maintenance Tool menu, select Schema Repository > Upgrade
> Selected Connection.

4 At the prompt to upgrade user databases, click Yes to continue.

5 Log in with Super User privileges.

6 Enter the properties of the schema repository to upgrade to (the empty database
you created in the production upgrade set), then click Next.

7 Enter the properties for the first user database you are upgrading to (the empty
databases you created in the production upgrade set). Click Next. Repeat until you
have associated all the user databases. Click Finish.

ClearQuest upgrades your schema repository and user databases, and notifies you
when the process is complete. It records all actions in a text file in the \Temp

directory.

8 Verify that the upgrade process completed successfully:

a When the upgrade process completes, carefully read the status message to
ensure that the process completed successfully (scroll until you reach the end of
the message). Click Done.

b Test the application. Enter a few test records of each record type and move
them though the entire state model to be sure the upgrade is working correctly.

9 After verifying that the upgrade completed successfully:

a To prevent users from accidentally using the original production databases,
either keep them locked or remove them.

b Optionally, discard the test bed and test upgrade set.
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Upgrading a Rational Project

This section describes how to upgrade datastores in a Rational project. It describes the
actions to take if:

� You need to update Rational Test or Rational RequisitePro datastores so you can
use them with the new version of Rational Suite. Datastores created with an earlier
version of Rational software are not compatible with the current version, 2002.
Therefore, before you can use these datastores, you need to convert them as
described in this section.

� You want to verify that ClearQuest packages are correctly configured for a
Rational project.

Upgrading the RequisitePro Database and Rational Test Datastores

Use the Rational Administrator to upgrade both RequisitePro databases and Rational
Test datastores as follows:

1 Start the Rational Administrator: click Start, then click Programs > Rational Suite >
Rational Administrator.

2 From the Administrator menu, select File > Upgrade Project Assets.

The Administrator displays a list of registered projects.

3 Select a project to upgrade and click OK.

The upgrade process starts. It first upgrades the RequisitePro database, if one is
associated with the Rational project, then it upgrades the Rational Test datastore, if
one is associated with the Rational project.

Upgrading the RequisitePro Database

The Rational Administrator displays the RequisitePro Database Upgrade Wizard.
While you work with the wizard, keep these points in mind:

� The Database Upgrade Wizard guides RequisitePro project administrators
through the process of upgrading existing database structure and project data to
the current RequisitePro release.

� If security is enabled for the project, enter your Rational RequisitePro User ID and
Password at the prompt. If there are multiple projects in an enterprise database,
type the User ID and Password used to create the enterprise database.

� After you upgrade the project database, users cannot open the associated projects
until they upgrade to the current version of RequisitePro.
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� If the project you are upgrading contains cross-project traceability links, you must
upgrade the external projects as well. If the external projects have security
enabled, you are prompted to log on to those projects while the Database Upgrade
Wizard is running. You can always check for references to external projects in any
RequisitePro project by clicking Project > External Projects.

� If an error occurs during the upgrade, the wizard displays an explanation of the
problem. Problems commonly occur when the wizard cannot get exclusive access
to the project or when the wizard cannot connect to external projects. After
addressing a problem, rerun the wizard to complete the upgrade.

After the Upgrade: Understanding RequisitePro Packages

Starting in RequisitePro version 2002, requirement artifacts are organized in
packages. Packages are containers, similar to file folders, in which you can group
artifacts or elements of different types. Packages in RequisitePro can contain
documents, requirements, views, and other packages, according to your
organizational needs.

Earlier versions of RequisitePro do not use packages. When you upgrade a project
created in an earlier version, the upgrade process automatically organizes your
requirements artifacts into packages. RequisitePro uses the following default scheme
to organize packages:

� Requirements Document. A package is created for each requirements document,
including all requirements that are located within that document.

� Requirement Type. A package is created for each requirement type, including
requirements of that type not located in documents.

A Requirement Type package is not created when there are no requirements
associated with the given type, or if all requirements of that type are already
located in Requirements Document packages.

� View Type. A package is created for each view type: Attribute Matrix, Traceability
Matrix, Traceability Tree. Each view package contains all views of that type in the
project.

Later you can create your own packages, and reorganize your requirement artifacts
accordingly.

Upgrading the Rational Test Datastore

During the upgrade, the Rational Administrator displays a progress indicator. When
it has finished, you can optionally click the View Log button to display a log of the
upgrade.
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Note that after you perform this conversion, you cannot revert to an earlier version of
the test datastore, nor can you use the upgraded test datastore with earlier versions of
Rational Test tools.

Converting to a Sybase SQL Anywhere Database

In previous releases, Microsoft Access was the default database engine for test
datastores. Starting with Version 2002, we strongly recommend that you convert to
using Sybase SQL Anywhere if two or more users plan to use the test datastore
simultaneously.

Microsoft Access is automatically installed when you install Rational software. The
Sybase SQL Anywhere database server ships with Rational software but is not
installed automatically.

For more information, refer to the Rational Testing Products Installation Guide to read
about:

� Installing and configuring a SQL Anywhere database server.
� Creating a SQL Anywhere test datastore.
� Converting a test datastore from Microsoft Access to SQL Anywhere.

After Upgrading a Rational Project

Perform these steps after upgrading the Rational project:

If You Use Rational ClearCase or Rational ClearCase LT

If you use Rational ClearCase or Rational ClearCase LT to store Rational data,

� If your team works with a UCM-enabled project:

a Use the Rational Administrator to perform a Check in All operation for the
RequisitePro project and the Test datastore. (In the Administrator, on the
Configure dialog box for your project, click Check in All for both datastores.
ClearCase checks in all project-related assets, then checks them out again.)
Until you perform this step, you will be unable to open the RequisitePro
project.

b Create a baseline for your project (in the ClearCase Project Explorer, select the
project, then click Tools > Make Baseline).

� If your team uses another method to integrate Rational Suite and ClearCase:

a Use ClearCase to check in the project’s assets.

b Use ClearCase to create a label on the checked-in versions. Name the label so
you will remember that these versions represent the upgrade.
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If You Use the Integration Between ClearQuest and RequisitePro

If you are using the integration between ClearQuest and RequisitePro, run the
ASCQISetup.bat utility if you edited it earlier. Running this utility creates the
associations between ClearQuest record types and RequisitePro requirements:

1 At a command line, change to the directory Install\Program Files\Rational\Common

and type ASCQISetup.

As the batch file runs, it pauses every time it creates an association and prompts
you to Press any key to continue.

2 Press ENTER until the batch file ends.

Verifying ClearQuest Packages for a Rational Project

If you are working with a Rational project, or if you have upgraded from a Rational
repository to a Rational project, you can verify that the ClearQuest packages for your
Rational project are correctly configured and upgraded:

1 Start the Rational Administrator: click Start, then click Programs > Rational Suite >
Rational Administrator.

2 In the left pane of the Administrator, select a project, right-click it, and select
Connect.

3 Select the same project, right-click it, and select Configure to display the Configure
Project dialog box.

4 Click Close to initiate the program that checks your project.

If the correct packages are applied, you do not see a message. However, if there are
packages to apply or upgrade, a message appears directing you to this chapter.

Upgrading Rational Process Workbench

When upgrading from an earlier version of Rational Process Workbench, pay
attention to these notes:

� To install Rational Process Workbench on your computer, perform a Custom
install, as outlined in the Rational Suite Installation Guide.

� To upgrade models, follow the instructions in the Readme file, available by
clicking Start, then Programs > Rational Suite Enterprise > Rational Process
Workbench > Readme.
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❑ If you are upgrading a model file originally created with Version 2001A, then
follow instructions to upgrade to a Version 2002 format.

❑ If you are upgrading a model file originally created with Version 2001, then
follow instructions to upgrade to a Version 2001A format and then to upgrade
to a Version 2002 format.

� To install the 2002 model and content library files, click Start, then click Programs >
Rational Suite Enterprise > Rational Process Workbench > Install RUP Model and
Content Library.

Finishing the Upgrade Process

You have finished with the upgrade process. Your team can now resume its work.
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9Setting Up Silent and
Network Installations
This chapter explains how to set up a silent installation and a network installation.

� A silent installation lets install a Rational Software product, using the same
parameters, repeatedly on a number of systems. Silent installations save system
administrators time and also control which products the users can use.

� A network installation lets you install the files needed on client systems to operate
Rational products from a network location. After the shared directory is set up,
users can select the network installation type in the Rational Software Setup
program.

� The last section in this chapter, Using Additional RSSetup Command Syntax on
page 126, provides additional syntax for the rssetup command.

Table 16 provides the steps to configure and perform a silent installation, and any
post-installation tasks.

Table 16 Silent Installation Tasks

To See

Record a silent installation � Recording a Software Installation on page 112
� Silent Installation Scenarios on page 120

Modify the response.ini file Modifying the Response.ini File (Optional) on page 114

Overwrite the response.ini file Overwriting the Response.ini File (Optional) on page 114

Prepare multiple response.ini files Preparing Multiple Response.ini Files (Optional) on
page 114

Perform a silent installation Performing a Silent Software Installation on page 118

Troubleshoot an unsuccessful silent
installation

Troubleshooting an Unsuccessful Silent Installation on
page 119

Specify post-installation commands � Specifying a Post-Installation Command (Optional) on
page 115

� Running the License Key Administrator Command
Line on page 116
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Table 17 provides steps to configure and perform network installations.

Configuring and Performing Silent Installations

To perform a silent installation, you perform these high-level steps, described in the
remainder of this section:

1 Record an installation session in a response.ini file.

2 Optionally, add a post-installation command to the response.ini file.

3 Perform the silent installation on a client system.

You can set up a Typical, Custom, Compact, or Network type of silent installation for
client systems. To read more about installation types in silent mode, see Silent
Installation Scenarios on page 120.

An upgrade installation of Rational software on clients is also possible. For more
information about the order of upgrade tasks, see Upgrading from Earlier Versions of
Rational Suite on page 79.

Recording a Software Installation

To record a software installation, run the Rational Software Setup program in
autocapture mode. Then use the resulting response.ini file to perform a silent
installation.

1 Insert the Rational Solutions for Windows Disc 1 in the CD-ROM drive.

2 Open a command window on the system and run rssetup (Rational Software
Setup program) with the -autocapture switch. For example:

<installation source directory>\setup\rssetup -autocapture

where <installation source directory> is the drive location of the Rational Solutions for
Windows CD-ROM.

Table 17 Network Installation Tasks

To See

Set up a shared directory Configuring the Setup Program for Network Installations
on page 124

Perform a network installation Performing a Network Installation on page 125
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3 When the Rational Software Setup program starts, proceed with the installation
procedure, as described in the chapter Installing Rational Suite – Administrator on
page 61. Your responses are recorded in the response.ini file in the default
installation path C:\Program Files\Rational. During the installation, you can specify
another installation directory.

Note: Do not configure licensing in the autocapture. The autocapture does not
capture license information in the response.ini file. Instead, you can append a
post-installation command to the file after you finish the recording. For
instructions, see Specifying a Post-Installation Command (Optional) on page 115.

4 When you reach the Confirmation screen that lists the products the Setup program
will install on the system, you can continue with the installation or exit from the
setup program. Click Cancel to exit. If you select OK, the program installs files in
non-silent mode onto the system. Regardless of whether you install program files
on the system, the Setup program creates the response.ini file.

Note: You can rename the response.ini file, change its location, or both after you
have finished recording the file.

5 Run the response.ini file to test it (Performing a Silent Software Installation on
page 118). To specify a license server, see Specifying a Post-Installation Command
(Optional) on page 115.

6 Configure a shared folder that contains the product files and Rational Software
Setup executable. See Configuring the Setup Program for Network Installations on
page 124 for the procedure. Copy the response.ini file to the same network location.

Note: Rational does not support copying the Rational Solutions for Windows disc
images to a network directory.

7 Before you give users the following information, see Ensuring Version Compatibility
on page 119.

Give users the:

a Location of the response.ini file.

b Silent installation command line syntax that includes the network location of
the Setup program executable and product files <installation source directory>.

c Location where the Rational Software Setup program will install the program
files on their systems.

Users can copy the response.ini file to their hard drives or they can point to the
response.ini file on the network.
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Modifying the Response.ini File (Optional)

You may want to modify the response.ini file so that an installation aborts if the
Rational Software Setup program detects older Rational products on the system.

Note: Rational Software supports only limited editing of the response.ini file. Do not
make changes other than those described in this chapter.

To modify the response.ini file:

1 Open up the response.ini file in a text editor.

2 Find the following lines at the end of the file, immediately preceding the
[PostInstallCmd] section:

[UpgradeRequired]

abort=no

Change the no to yes so that the section now reads:

[UpgradeRequired]

abort=yes

3 Save the file.

If an earlier version of a Rational product is installed on a user’s system, and the user
runs the response.ini file, the installation will stop before it completes.

Overwriting the Response.ini File (Optional)

If you need to overwrite the response.ini file, the Rational Software Setup program
initially chooses the product selected in the previously recorded response.ini file in the
Choose Product screen. The program lets you select a new product, and saves a new
version of the response.ini file at the end of the installation procedure.

Preparing Multiple Response.ini Files (Optional)

You can save multiple response.ini files to support an unattended installation of
different products.

1 Identify a directory where you will store your response.ini files. The following
examples use a directory named C:\responses.

2 Record the response.ini file for one of the products to install.

3 Rename the response file with a unique file name. For example, save the Rose
response file as C:\responses\Rose-response.ini.
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4 Repeat Steps 2 and 3 for the other products to install.

5 Specify the path to each response.ini file in the -response:response-path

parameter for your users. They have to use the -response parameter with the
-silent parameter when they run the silent installation for each product. The
entire syntax must be entered on one line. They must use a separate command line
for each response.ini file.

Example command syntax for one response.ini file:
<installation source directory>\setup\rssetup -silent

-response:C:\responses\Rose-response.ini

where <installation source directory> is the network location of the shared folder that
contains the Rational Software Setup executable and product files. See Configuring
the Setup Program for Network Installations on page 124 for the set up procedure.

Specifying a Post-Installation Command (Optional)

The post-installation section of the response.ini file contains commands that run after
the installation finishes. Use the post-installation command to specify single,
multiple, and redundant Rational license servers in the Rational License Key
Administrator.

Perform the following steps after you record a response.ini file:

1 Use a text editor such as Notepad to edit the response.ini file. Append a line similar
to the following example to the end of the file. The label [PostInstallCmd] is
required:
[PostInstallCmd]
Command=post-installation-commands.bat

2 The post-installation-commands.bat is a batch file that contains the commands to
execute. Such a file might contain the following commands:
licadmin -fserver-info.txt

net send administrator “Installation Complete”

In this example, the License Key Administrator, licadmin, starts and uses the
information in server-info.txt to specify the name of the license server that the
current system will use. (See Running the License Key Administrator Command Line
on page 116 for the procedure.) The batch file then sends a message to the
administrator, indicating that the installation procedure is complete.

3 Save the response.ini file to a unique name (to ensure that it is not overwritten by
subsequent autocaptures). For example, save the response file with a name such as
C:\responses\enterprise-windows-post.ini.
Configuring and Performing Silent Installations 115



Running the License Key Administrator Command Line

Run the Rational License Key Administrator from a command line or batch file to
automate Rational licensing. Use the following commands in a text file to specify
single, multiple, and redundant license servers.

Note: You cannot import a node-locked license key onto your system with the
post-installation command.

Specifying a Single License Server

To specify the name of a single Rational license server in a client’s License Key
Administrator:

1 Create a file in a text editor, such as Notepad, that contains the following line:
Server:group-license-server

where group-license-server is the name of your Rational license server
system. The keyword Server is case-sensitive.

2 Save the file, for example, server-info.txt.

3 In a command window or a batch file, enter the following command:
licadmin -fserver-info.txt

Your system will be configured to use floating license keys from
group-license-server.

The results of running this command are written to the status file
server-info.txt_STATUS, where server-info.txt is the name of the license parameter file you
created. The status file is created in the directory where you executed the licadmin
command.

After the system reads the server-info.txt file, the server-info.txt_STATUS file is created.
Users can check for the existence of this file in the installation directory to verify that
the server-info.txt file has been read.

Here is an example of a server-info.txt_STATUS file:

SUCCESS
***Opened Input File @ 03:41 PM on 10/01/1999
***File Contents are:
Server: mygroup-licenses
***End File Contents.
***Starting Work
***Processing Server:
Server: mygroup-licenses

Server found. Name is mygroup-licenses
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Common Directory Found
Use License Server Registry Key set
License Server Name Registry Key set
Redirect File opened correctly

Specifying a Second License Server

To specify the names of two license servers (this is not a redundant server
configuration) in a client’s License Key Administrator:

1 Create a file in a text editor, such as Notepad, that contains the following lines:
Server:license-server or Server:27000@license-server
AlternateServer:27000@license-server2
where license-server is the name of the first license server and
27000@license-server2 is the name of the second license server. The
keywords Server and AlternateServer are case sensitive.

When you enter these lines, you must:

❑ Specify the second license server in a port@host format. You can specify the
first license server in either hostname or port@host format. For more
information about ports, see the Rational Suite License Management Guide.

❑ Use the keywords Server and AlternateServer in the text file. You cannot
specify an alternate server without a primary server.

2 Save the file, for example, server-info.txt.

3 In a command window or a batch file, enter the following command:
licadmin -fserver-info.txt

Your system will be configured to use floating license keys from
license-server and license-server2

The results of running this command are written to the status file
server-info.txt_STATUS, where server-info.txt is the name of the license parameter file you
created. The status file is created in the directory where you executed the licadmin
command.

After the system reads the server-info.txt file, the server-info.txt_STATUS file is created.
Users can check for the existence of this file in the installation directory to verify that
the server-info.txt file has been read.

Specifying Redundant License Servers

To specify the names of redundant license servers in a client’s License Key
Administrator:
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1 Create a file in a text editor, such as Notepad, that contains the following line:
RedundantServer: 27000@license-server,
27000@license-server2, 27000@license-server3

When you enter this line:

❑ The license servers must be specified in a port@host format and in the order
of Primary, Secondary, and Tertiary (Backup) server. For more information
about ports and redundant server order, see the Rational Suite License
Management Guide.

❑ The keyword RedundantServer is case sensitive.

❑ The keyword RedundantServer cannot be used with the keywords Server
and AlternateServer in the text file. You cannot specify redundant servers
and multiple servers in one file.

2 Save the file, for example, server-info.txt.

3 In a command window or a batch file, enter the following command:
licadmin -fserver-info.txt

The results of running this command are written to the status file
server-info.txt_STATUS, where server-info.txt is the name of the license parameter file you
created. The status file is created in the directory where you executed the licadmin
command.

After the system reads the server-info.txt file, the server-info.txt_STATUS file is created.
Users can check for the existence of this file in the installation directory to verify that
the server-info.txt file has been read.

Performing a Silent Software Installation

After you record your responses, and optionally, edit the response.ini file, run the
installation by using the following commands:

<installation source directory>\setup\rssetup -silent

The <installation source directory> is the location of the product files and Rational
Software Setup program executable (from the Rational Solutions for Windows
CD-ROMs) in a shared directory. The Setup program (in the installation source
directory) installs the Rational product specified in the response.ini file to an
installation directory that you specified in the Setup program or to the default
installation directory C:\Program Files\Rational.

Warning: Before giving the installation syntax to users, find out where users have
Rational program files installed on their systems because Rational
installations in two different places affect software performance. The silent
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installation installs the latest program files in the location that you specified
in the response.ini file. If users have installations in different places on their
systems, they may have difficulty removing the files with the standard
removal procedure described in Removing Rational Suite – Client on page 41.

Renaming or Moving the Response.ini File

If you rename the response.ini file or move it from the installation directory, enter the
-response:response-path parameter on the same line.

<installation source directory>\setup\rssetup -silent -response:response-path

The response-path includes the entire path, including the directory and filename.

Ensuring Version Compatibility

In a non-silent installation, users see the Upgrade Compatibility dialog box if Rational
Software Setup detects earlier versions of products on the system. During a silent
installation, they do not see the Upgrade Compatibility dialog box if the Setup program
detects older software. Instead, this message appears in the Setup log file
(<Install Path>\Rational\RSSetup\RSSetup.log); however, users may not remember to look
in this file after they run the silent installation. To prevent upgrade compatibility
problems, have users perform the tasks in Ensuring Version Compatibility on page 23
before they perform the silent installation.

Troubleshooting an Unsuccessful Silent Installation

If a silent installation aborts before completion because a non-upgraded Rational
product exists on the system, manually install a product to find out which product(s)
are on the user's system. Then either remove the additional products or upgrade all
products sequentially.

Warning: Do not run any of the products until all have been upgraded because some
of the non-upgraded products may stop working.

To upgrade products sequentially, you have these options:

� Create silent installations for each product and run them. Do not change the
default value of “no” for abort in the [UpgradeRequired] section of the
response.ini file.

� Run manual installations for each product.
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Silent Installation Scenarios

The following scenarios describe some of the common paths that silent installations
might take, depending on installation type.

Typical Silent Installation

A Typical installation type installs the features needed by a typical user to use the
product effectively. In this scenario, the system administrator records a response.ini file
that users can run to install Rational ClearQuest on their systems.

When the system administrator records the response.ini file, the administrator selects
ClearQuest as the product to install and the location where the ClearQuest files will
be installed. The response.ini file is also placed in this installation path. After the
response.ini file is created, the administrator edits the response.ini file with a
post-installation command to specify the Rational license server.

After the installation, the user can operate ClearQuest because the post-installation
command specifies the floating license server on their systems. If the company had
instead purchased node-locked licenses for ClearQuest, users would have to
manually import the licenses on their systems.

The following procedure describes how to run the autocapture of a typical
installation, distribute the response.ini file to users, and give users the command to run
the silent installation.

1 Run rssetup.exe (Rational Software Setup program) from the command line, using
the -autocapture switch to record a response.ini file.

2 In the Setup program’s non-silent mode,

a Choose the product to install (ClearQuest).

b Select the path where the response.ini file will be located. If no path is chosen,
the default path is C:\Program Files\Rational\RSSetup. The location of the
response.ini file is also the installation path for the product files.

c Choose the installation type. In this example, the installation is Typical.

d The installation program asks whether to complete the installation. Click
Cancel so that no actual installation occurs on your system.

3 Open the response.ini file in a text editor and add the following post-installation
command lines to the end of the file:

[PostInstallCmd]

Command=licadmin -fserver.txt
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where -f is the filename parameter for the License Key Administrator and
server.txt is a text file. This text file contains the name of the license server host
name in the form Server:group-license-server, where
group-license-server is the name of the license server system. This
command points the user's system to the correct license server after they run the
response.ini file to install ClearQuest on their systems.

4 Save the response.ini file and rename the file to match the product to install, for
example, clearquest.ini.

5 Copy the response.ini file to a network location so users can access the file.

6 Tell users where on the network to find clearquest.ini and to use the file to install
ClearQuest on their systems. The users can copy clearquest.ini to their systems’
hard drives, or they can point to clearquest.ini on the network if they prefer not to
copy it to their systems.

7 Each user runs the following command on the command line (enter on one line
without breaks) to install ClearQuest on their systems:

rssetup.exe -silent -response:\\server\drive\subdirectory\clearquest.ini

After the user runs the command, ClearQuest is installed on their systems. Each
user can use the product because the administrator has supplied a pointer to the
correct license server in the server.txt file.

Example of a Network Silent Installation

A Network installation type configures your system to run the product from a
network folder. In this example, the company has purchased Rational RequisitePro
and wants all 500 users to access RequisitePro on a network.

The system administrator sets up a shared directory of Rational installation CD(s),
and then configures a response.ini file for a silent network installation of RequisitePro.
Users run the response.ini to install the necessary files on their systems so they can
operate RequisitePro from the network location. The post-installation command in the
response.ini file specifies the floating license server.

The following procedure describes how to run the autocapture of a network
installation, distribute the response.ini file to users, and give users the command to run
the silent installation.
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1 Configure the Rational Software Setup program to install program files to a shared
directory on the network. For more information, see Configuring the Setup Program
for Network Installations on page 124.

2 Run rssetup.exe from the command line, using the -autocapture switch to
record a response.ini file.

3 In the Rational Software Setup program’s non-silent mode:

a Choose the product to install (RequisitePro).

b Select the path on which the response.ini file will be located. If no path is chosen,
the default path is C:\Program Files\Rational\RSSetup. The location of the
response.ini file is also the installation path for the product files.

c Choose the installation type. In this example, the installation is Network.

d The installation program asks whether to complete the installation. Click
Cancel so that no actual installation occurs on your system.

4 Open the response.ini file in a text editor and add the following command lines to
the end of the file:

[PostInstallCmd]

Command=licadmin -fserver.txt

where -f is the filename parameter for the License Key Administrator and
server.txt is a text file. This text file contains the name of the license server host
name in the form Server:group-license-server, where
group-license-server is the name of the license server system. This
command points the user's system to the correct license server after they run the
response.ini file to install ClearQuest on their systems.

5 Save the response.ini file and rename the file to match the product to install, for
example, reqpro.ini.

6 Copy the response.ini file to a network location so users can access the file.

7 Tell the users where on the network to find reqpro.ini and to use the file to install
RequisitePro on their systems. They can copy reqpro.ini to their systems’ hard
drives, or they can point to reqpro.ini on the network if they prefer not to copy it to
their systems.

8 Each user runs the following command on the command line (enter on one line
without breaks) to install RequisitePro on their systems:

rssetup.exe -silent -response:\\server\drive\subdirectory\reqpro.ini
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After the user runs the command, the silent installation installs the files (shared
system DLLs and local configuration settings) needed on the client systems to run
Rational RequisitePro (program files and executables) from the network directory.
Each user can immediately start using the product because the administrator has
supplied a pointer to the correct license server in the server.txt file.

Example of a Custom Silent Installation

The Custom installation type enables you to specify which products or features to
install. In this example, the developer (project leader) supervising ten other
developers needs to specify which parts of Rational Rose 2000 Enterprise Edition will
be installed on each developer’s system. The developer has purchased node-locked
licenses for this product.

The project leader records a response.ini file for a Custom installation of Rational Rose
2000 Enterprise. The project leader chooses to install Rose 2000 Enterprise, but clears
options in the Custom installation screen. The developers run the response.ini to install
the customized Rose Enterprise. There is no post-installation command appended to
the response.ini file because the Rational License Key Administrator does not support
a post-installation command that imports node-locked license keys. The developers
must manually import the node-locked licenses on their systems.

The following procedure describes how to run the autocapture of a custom
installation, distribute the response.ini file to users, and give users the command to run
the silent installation.

1 Run rssetup.exe (Rational Software Setup program) from the command line, using
the -autocapture switch to record a response.ini file.

2 In the Setup program’s non-silent mode,

a Choose the product to install (Rational Rose 2000 Enterprise Edition).

b Select the path on which the response.ini file will be located. If no path is chosen,
the default path is C:\Program Files\Rational\RSSetup.

c Choose the installation type. In this example, the installation is Custom.

d Clear the individual items (such as the Visual Basic add-in, the Java add-in, or
the Rose Web Publisher add-in) in Rose 2000 Enterprise that you want to
exclude from the installation.

e The installation program asks whether to complete the installation. Click
Cancel so that no actual installation occurs on your system.

3 Rename the response.ini file to match the product to install, for example, rose.ini.

4 Copy the response.ini file to a network location so users can access the file.
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5 Tell the users where on the network to find rose.ini and to use the file to install
RequisitePro on their systems. They can copy rose.ini to their systems’ hard drives,
or they can point to rose.ini on the network if they prefer not to copy it to their
systems.

6 Each user runs the following command on the command line to install Rose on
their systems:

rssetup.exe -silent -response:\\server\drive\subdirectory\rose.ini

After each user runs the command, the customized Rose Enterprise is installed on
their systems, but they still need a license key to operate Rose. They then import
the node-locked license key files on their systems.

Configuring and Performing Network Installations

Using the command line, you can direct the Rational Software Setup program to copy
and decompress product files to a network folder. This network directory provides an
rssetup executable from which users on client systems can perform network
installations. The network option in the Setup program installs the files (shared
system DLLs and local configuration settings) needed on the client systems to run
Rational products (program files and executables) from the shared folder. If users
want to install an additional Rational product from the same release, they can perform
another network installation from the shared folder that you set up.

Warning: If ClearQuest MultiSite and the Rational Shipping Server are part of your
Suite edition, do not set up a network installation because network
installations do not let you select component features.

Configuring the Setup Program for Network Installations

This section provides the instructions for directing the Rational Software Setup
program to copy and decompress the product files to a shared folder. All product files
in a Rational Solutions for Windows disc are compressed into .cab files. Before the
Rational Software Setup program can offer a network installation option to clients, the
Setup program needs to expand the .cab files in this shared folder.

The network location that you select must have at least 2.6 GB of space to
accommodate the expanded files. You must have write permission to set up this
directory.

There are two conditions in which the Rational Software Setup does not provide the
network installation option to users.
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� Rational products have already been installed on the system using a different
installation type.

� Rational ClearCase LT Server, Rational Test Enablers, and RequisiteWeb do not
allow network installations.

Note: If earlier versions of Rational products are installed on server or client systems,
do not perform upgrades with the network installation type. For more information
about upgrades, see Upgrading from Earlier Versions of Rational Suite on page 79.

To set up the directory on the network:

1 Insert the Rational Solutions for Windows Disc 1 in your CD-ROM drive.

2 Open a command window on your system and enter the rssetup command:

<location>\setup\rssetup.exe -Admin:<dir>

Where <location> is the location of the Rational Solutions for Windows disc and <dir>

is the target directory name. There is no space between -Admin: and the directory
name.

3 The Rational Software Setup program prompts you to start the procedure by
clicking Next. Depending on the product you select, the program may require you
to insert another Rational Solutions for Windows disc in the drive.

4 At the end of the procedure, the Installation Complete screen asks you to complete
the procedure. Click Finish to complete the installation.

5 We recommend that you set this network directory and all subdirectories to
read-only for users who will perform the network installation.

Performing a Network Installation

Give users the following information before they select the network installation
option in the Setup program.

1 If users have already used a different installation type to install Rational products
on their systems, they will have to remove the products. If they leave the products
on their systems, the network installation option will not be available.

2 Users cannot use the network installation type to install Rational ClearCase LT
Server, Rational Test Enablers, and RequisiteWeb.

3 Users need 584 MB disk space on their systems to accommodate the shared system
DLLs and local configuration settings the Setup program will install on their
systems.
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4 Users should map a drive on their local systems to the network folder where you
expanded the Rational product files and Rational Software Setup executable. Tell
users to start Windows Explorer and click Tools > Map Network Drive. In the Map
Network Drive dialog box, users must enter the folder location and select Reconnect
at Logon. If they do not select this option, the installation will not automatically
complete after the system restarts.

Then they can go to the mapped drive on their systems and double-click setup.exe.
In the Select Configuration dialog box of the Rational Software Setup program,
they select Network.

Using Additional RSSetup Command Syntax

Table 18 and Table 19 provide additional command line syntax that you can use with
the Rational Software Setup program.

rssetup [-silent [-response:response-path]]
[-verbose [-response:response-path]]
[-autocapture]
[-product <product>] [-uninstall]

Table 18 RSSetup Command Syntax Definitions

Parameter Description

-verbose Replays a recorded installation, allowing you to
override the recorded responses. However, the
changes are not written to the response.ini file.

-product
product-identifier

Specifies the product you are installing or
uninstalling.

Do not use this parameter for silent installations. For
a silent installation, specify the product name in the
response.ini file instead.

See Table 19 on page 127 for the list of identifiers you
can use with this parameter.

-uninstall Removes the product you specified with the
-product switch.

Do not use this parameter for silent installations. See
Removing Rational Suite – Administrator on page 129
for alternative and additional removal instructions.
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Table 19 lists the product identifiers to use with the -product switch.

Table 19 Product Identifiers

Product Name Product Identifiers

Rational Test Agent atbuPSAgent

Rational Test Enablers atbuSetupEnablers

Rational TestManager atbuTestManager

Rational TeamTest atbuTeamTest

Rational Robot atbuTSRobot

Rational ClearCase LT Client ClearCaseLTClient

Rational ClearCase LT Server ClearCaseLTServer

Rational ClearQuest ClearQuest-1.1

Rational ClearQuest TeamTest Edition ClearQuestTeamTestEdition-1.1

Rational ContentStudio ContentStudio

Rational PureCoverage coverageNT

Rational Developer Kit dsbuDeveloperKit

Rational Suite DevelopmentStudio for
UNIX

dsbuRSDSU

Rational Purify purifyNT

Rational PurifyPlus purifyplus

Rational Quantify quantifyNT

Rational RequisitePro rmbuRequisitePro

Rational Rose Enterprise Edition Rose98i

Rational Rose Professional Ada Edition Rose98iAdaProfessional

Rational Rose Professional C++ Edition Rose98iC++Professional

Rational Rose Professional J Edition Rose98iJavaProfessional

Rational Rose Modeler Edition Rose98iModeler

Rational Rose Professional Visual Basic
Edition

Rose98iVBProfessional
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Rational Rose Professional Data Modeler
Edition

RoseDataModelerProfessional

Rational Rose RealTime RoseRealTime

Rational Unified Process ruObjectory51

Rational SoDA for Word SoDA

Rational Suite AnalystStudio wsbuAnalystEdition

Rational Suite DevelopmentStudio wsbuDevelopmentStudio

Rational Suite DevelopmentStudio -
RealTime Edition

wsbuDevelopmentStudioRT

Rational Suite Enterprise wsbuEnterprise

Rational License Server wsbuFLEXlmServer

Sybase SQL Anywhere Database Server wsbuSQLAnywhereServer

Rational Suite TestStudio wsbuTestStudio

Rational Suite Team Unifying Platform wsbuUnifyingPlatform

Table 19 Product Identifiers (continued)

Product Name Product Identifiers
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10Removing Rational Suite
– Administrator
This chapter describes the requirements and procedure for removing Rational Suite
from server systems.

Before You Remove Rational Suite

This section provides general requirements for removing Rational Suite. It also
describes which components the Rational Software Setup program does or does not
remove from the system.

� If you plan to move the application to another system, first return the license key
file to your Rational Software account. To return a license key, use Rational
AccountLink (www.rational.com/accountlink), the online license management tool.
For more information about moving licenses or returning licenses, see the Rational
Suite License Management Guide.

� Removing an earlier version of Rational Suite does not delete the license key file,
project databases, and other files that you created while using Rational Suite. If
you plan to install an upgrade of Rational Suite to a different drive or use a new
installation path, back up these files and manually remove them. If you do not
remove them, the Rational Software Setup program may find these files and install
the appplication in the old location instead of the new location.

� To remove Rational Software products from a Windows NT, 2000, or XP system,
you must have Windows administrator privileges on the local system.

� Make sure that no one is using the application or any associated files. You cannot
remove files that are in use.

Removing Rational Suite

Use the Windows Add/Remove Programs control panel to select and remove Rational
Suite.
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Additional Removal Instructions

This section explains additional product-specific procedures for removing Rational
Suite.

Removing ClearCase LT Data from a ClearCase LT Server

You can remove ClearCase LT and all ClearCase LT data (VOBs, views, and storage
locations), or you can simply remove ClearCase LT.

Warning: ClearCase LT data may be valuable. Do not remove it unless you know that
the data is not important.

You do not need to remove ClearCase LT data from a ClearCase LT server unless you
intend to reinstall ClearCase LT server on the system and rerun the Server Setup
Wizard to create a new set of VOBs. If you want to rerun the Server Setup, delete the
following registry key:

HKLM\Software\Atria\ClearCase\CurrentVersion\ServerSetupComplete

and remove the ClearCase LT data. If you do not perform these tasks, you may
encounter errors when the Server Setup starts.

To remove ClearCase LT data from the ClearCase LT server:

1 Use the ClearCase Administration Console or the cleartool lsvob command to
locate all the VOBs on the ClearCase LT server. Then use the ClearCase
Administration Console or the cleartool rmvob command to remove the VOBs.

2 Use the ClearCase Administration Console or the cleartool lsview command to
locate all the views. Then use the ClearCase Administration Console or the
cleartool rmview command to remove the views.

3 Use the ClearCase Administration Console or the cleartool lsstgloc command to
locate all the server storage locations. Then use the ClearCase Administration
Console or the cleartool rmstgloc command to remove the storage locations.

4 To remove registry values, use regedit to remove these lines:

HKLM\Software\Atria\ClearCase\CurrentVersion\ServerSetupComplete

HKLM\Software\Atria\ClearCase\CurrentVersion\CredmapAllowedDomainList

5 Delete the ClearCase LT /var directory from the installation directory.

Removing Rational RequisiteWeb

See the RequisitePro installation manual for removal instructions.
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Removing Rational Testing Products

The following Rational testing software require special removal instructions.

To Remove See

UNIX Test Agent “Removing a UNIX Agent” in the user guide
for Rational testing products.

Rational Test network driver “Removing the Rational Test Network
Driver” in the user guide for Rational testing
products.
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11Applying Service
Releases – Administrator
As of release 2002, Rational Software is distributing a Service Release approximately
every two to three months. This update mechanism provides cumulative fixes for
multiple products in one program.

� A Service Release, similar to a synchronized patch, is developed for a specific
product-version and does not affect the licensing of your products. Since there is
no effect on licensing, the Service Release program does not let you configure
licensing as you apply it to the software.

� A Service Release, unlike a synchronized patch, detects the products on your
system and updates the program components. You do not have to find and select
product-specific patches.

Because a Service Release is cumulative, you can apply the latest Service Release
without applying earlier Service Releases. After you apply a Service Release, you may
see new shortcuts or files, but no new features or products. The Service Release
updates the Rational product’s version number from, for example, 2002.05.00.293.000
to 2002.05.01.293.000. You can see the change in the About Rational Product dialog in
the toolbar’s Help pull-down menu or in the Rational Installed Product Information
dialog on the Start menu.

Applying Service Releases to Supported Configurations

This section provides guidelines for installing Rational Service Releases.

� If you are an administrator, find Service Releases at
http://www.rational.com/support/downloadcenter/index.jsp. You must have administrator
privileges to download the program from this Web site. This Web site and the
Service Release program provide the release notes for each Service Release.

� If you are a client user, speak to your system administrator before you try to
download a service release from the Rational web site.

You can apply Service Releases to these configurations:

� Typical, Custom, and Compact installation types
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� Installations where earlier Service Releases have been applied

Note: You can copy the Service Release program to a directory on the network, but
you cannot configure the Service Release program for a network installation type.
Network installations are explained in Configuring and Performing Network Installations
on page 124.

Installing an Additional Product to an Updated System

When you install an additional product from the Rational Solutions for Windows
CD-ROM to a system that already has had a Service Release applied to it, the Setup
program warns you that the products on your system are updated. Continue with the
installation and then re-apply the Service Release to update the additional product.

Applying Service Releases to Unsupported Configurations

If the Service Release detects an unsupported configuration, such as a network
installation, it cannot update the components. Instead, the program displays a
warning message about the incompatibility between the Service Release and the
installed products.

You cannot apply a Service Release to:

� A product-version for which it was not intended.
� A specific product if you have multiple products on one system.
� A directory that was configured for a network installation type.
� Multiple versions of Rational Software (but no Service Releases) on the same

system.
� A system that had a more current Service Release applied to it. That is, applying an

earlier Service Release to a later Service Release is not supported.

Removing a Service Release

You cannot remove just the Service Release from your system. To remove the Service
Release, remove all Rational products from your system and then re-install the
products.

Deploying a Service Release in the Silent Mode

To deploy a Service Release in silent mode, do not record your responses in a
response.ini file. No autocapture or post-installation command is necessary because
the program does not offer options. Instruct users to perform the silent installation
explained in the following procedure. For more information, see Configuring and
Performing Silent Installations on page 112.
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To apply a Service Release in silent mode:

1 Copy the Service Release program files to a directory on the network.

2 Instruct users to run the installation by entering the following command on the
command line:

<installation source directory>\setup\rssetup -silent

The <installation source directory> is the location of the product files and Service
Release program executable in the shared directory. The program (in the
installation source directory) detects the products on the user’s system and
updates the files.

3 Have users check their rssetup.log file for warnings or error messages about
unsupported configurations. A silent installation does not display messages.
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12Troubleshooting
If you have any problems running the Rational Software Setup program or setting up
a silent installation, read Table 20 and the index of error messages in the Rational
Software Setup Help.

Installation Messages

Installation error messages, including messages for silent installations, are displayed
in the file <Install Path>\RSSetup\Error.log.

Table 20 describes some errors that you may encounter when you configure a silent
installation.

Table 20 Silent Installation Messages

Message Description

Product “ProductName” specified in
response file is not contained in the
product list.

This message appears when the response.ini
file contains an invalid product name.

Unable to open response file. Typically, this error occurs when the installation
procedure cannot locate the response.ini file.
Either you have specified an incorrect path or the
response.ini file is not in the default location.

Information required to remove the
specified product cannot be found.
The product may not be removed
automatically.

When you tried to remove a product with the
/uninstall switch, you either specified a product
that is not installed on your system or you
incorrectly typed the product name on the
command line.

Confirm that you are specifying a product on
your system. Confirm that you have typed the
product name exactly as it appears in the
Rational Software Setup program.
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Support Information

Contact Rational Support if you have questions about the installation, use, or
maintenance of Rational Software products.

Contacting Rational Technical Support on page xvi provides Rational Technical Support
telephone and e-mail contact information.
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